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ABSTRACT 

The aim of this project is to develop a 3D educational mobile application to help high school 

students and anyone without a medical background to understand the human femur bone and 

its potential shaft fracture. The application provides interactive and immersive visualisations 

of the femur bone, common types of fractures, and their corresponding treatment options. The 

application is designed to be user-friendly and accessible to everyone, providing a 

comprehensive and engaging educational resource. The project utilised technologies such as 

Blender to create the 3D models, Unity to develop the application and Firebase for the backend 

infrastructure. The application was tested and evaluated by a group of users without a medical 

background, who provided valuable feedback to enhance the user experience. Overall, this 

project provides a novel approach to the educational field and has the potential to increase the 

awareness of femoral shaft fractures among non-medical professionals, promoting a better 

understanding of human anatomy and injuries. 
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Chapter 1 

Introduction 
 

1.1 Background 

The femur, also known as the thigh bone, is the strongest, longest, and heaviest bone in the 

human body. It plays an important role in supporting 30 times of human body weight and 

stabilizing the pace, as well as for humans to carry out several activities in daily life, such as 

walking, jumping, and running [1]. Even though the femur is so strong, it can be broken. For 

instance, [2] updated that people who are in a serious accident, such as a motorcycle crash that 

had resulted in high-impact injuries. Besides, long-distance runners may suffer a femoral shaft 

stress fracture because of bearing stress for a long time. Not only that, but older adults with 

osteopenia can also break their femur shaft, if they fall from a standing position. Osteopenia 

means the bone density and mass is lost but is not as severe as osteoporosis. Both osteopenia 

and osteoporosis have a lower level of bone density than normal. Bone mineral density (BMD) 

testing can be used to identify these diseases, where the T score for osteopenia is between -1 

to -2.5, and for osteoporosis is -2.5 and lower. These diseases began without any symptoms 

and are difficult to be aware of. There are several factors that cause these diseases, such as 

aging, hormonal changes, smoking, excessive alcohol consumption, sedentary lifestyle, and 

genetics [21]. Women who are undergoing the menopausal transition period or postmenopausal 

women are also at a high risk to be diagnosed with osteopenia because the decrease in estrogen 

results in greater bone resorption than production [34]. Osteopenia and osteoporosis cannot be 

fully cured, but having a balanced diet and exercising regularly can control and slow down 

bone loss [21]. Figure 1.1 indicates the stages of osteoporosis. 

Table 1.1-1: T score of osteopenia, osteoporosis and normal bone 

 Normal Osteopenia Osteoporosis 

T score 

(Bone density) 

1 to -1 -1 to -2.5 -2.5 and lower 
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Figure 1.1-1: Stages of Osteoporosis 

 

 

Figure 1.1-2 Classification of Femoral Shaft Fractures (Source: Torres, Lycans & Goel, 2017) 

 

Figure 1.1-3 Types of Femoral Shaft Fractures (Source: MD, 2019) 
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As Figure 1.1-2 shows, the Winquist and Hansen classification that have been proposed in 1980 

by Winquist divides femoral shaft fractures according to the degree of comminution, which is 

from the lightest, type 0 to the most serious, type IV. The purpose of the classification of 

femoral shaft fractures is to make management decisions for treatment, whether requires an 

intramedullary nail or open reduction [3]. A fracture without comminuted is known as type 0, 

a fracture with a small butterfly fragment that is less than a quarter of the bone’s breath is 

known as type I, and a fracture with a butterfly fragment that is half or less the width of the 

bone is known as type II, a fracture comminuted with a huge butterfly fragment that is more 

than half of the bone’s breath is known as type III, whereas, a fracture with significant 

comminuted of a whole bone section is known as type IV. Table 1.1-2 presented easy and 

understandable information along with the reference pictures.  

Femoral shaft fractures can be further divided into different types, such as transverse, linear, 

oblique, spiral, greenstick, and comminuted as in Figure 1.1-3 shown [4]. According to 

Aaos.org, the most common types of femoral shaft fractures are transverse, oblique, spiral, 

comminuted, and open, where the open fracture represents the fragment of bone stuck out 

through the skin [5]. There are some descriptions and reference pictures of the types of fractures 

shown in Table 1.1-5. As a result of the high accuracy and reliability of AO/OTA Classification 

for long-bone fractures, it is most often used to classify the different types of fractures [35]. 

Different from Winquist and Hansen Classification, AO/OTA Classification classified femoral 

shaft fractures into 3 main types, which are simple (A), wedge (B), and complex (C) [22]. Since 

the femur is regarded as the third bone and the midshaft as the second segment, the AO/OTA 

classification delegates this fracture naming 32 [23].  

Not only that, but the femoral shaft fractures can also be represented in different categories 

according to their seriousness and location, such as displaced, 

non-displaced, closed, and open as shown in Figure 1.1-4. For 

displaced fracture, the bone is snapped into 2 or more parts and 

moved out of alignment, while for non-displaced fracture, the 

bone is cracked without moving out of the alignment. For open 

fractures or compound fractures, the bone is broken through the 

skin, while for closed fractures or simple fractures, the bone 

cracked without piercing the skin [33].  

Figure 1.1-4: Fracture Category 
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The Gustilo Anderson classification is another system for categorising the seriousness of open 

or compound fracture. It primarily classifies soft-tissue injuries from open fractures into 3 

grades, namely Type I, Type II, and Type II, with Type III itself being further classified into 3 

subgroups (Type IIIA, Type IIIB, Type IIIC) [58]. In Table 1.1-4, references images and 

damage levels for various open fracture grades according to Gustilo Anderson classification 

are presented. 

Table 1.1-2: Winquist & Hansen Classification 

Winquist and Hansen Classification [24] 

     
Figure 1.1-5: Type 0 of Winquist  

    & Hansen Classification 

Type 0 

•  No comminution 
 

     
Figure 1.1-6: Type I of Winquist  

    & Hansen Classification 

Type I 

• Small butterfly fragment < 25% of the bone’s breath  
 

     
Figure 1.1-7: Type II of Winquist  

    & Hansen Classification 

Type II 

• Butterfly fragment < 50% of the bone’s breath 
 



Bachelor of Information Systems (Honours) Information Systems Engineering  
Faculty of Information and Communication Technology (Kampar Campus), UTAR 
                                                         

5 
 

     
Figure 1.1-8: Type III of Winquist  

    & Hansen Classification 

Type III 

• Huge butterfly fragment > 50% of the bone’s breath 

 

     
Figure 1.1-9: Type IV of Winquist  

    & Hansen Classification 

Type IV 

• Significant comminuted of a whole bone section 
 

Table 1.1-3: AO/OTA Classification 

AO/OTA Classification [24] 

Type 32A – Simple 

 
Figure 1.1-10: AO/OTA Type 32A 

A1 – Spiral 

A2 – Oblique, angle > 30 degrees 

A3 – Transverse, angle < 30 degrees 

Does not break the skin 

Type 32B – Wedge 

 
Figure 1.1-11: AO/OTA Type 32B 

B1 – Spiral wedge 

B2 – Bending wedge  

B3 – Fragmented wedge 

Type 32C – Complex 

 
Figure 1.1-12: AO/OTA Type 32C 

C1 – Spiral 

C2 – Segmental 

C3 – Irregular 
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Table 1.1-4: Gustilo Anderson Classification 

Gustilo Anderson Classification [58] 

Type I 

 
Figure 1.1-13: Type I of Gustilo Anderson 

Classification 

• Low energy 

• Wound size ≤ 1 cm 

• Minimal soft tissue damage 

• Minimal comminution of fracture 

Type II 

 
Figure 1.1-14: Type II of Gustilo Anderson 

Classification 

• Moderate energy 

• Wound size between 1 – 10 cm 

• Moderate soft tissue damage 

• Moderate comminution of fracture 

Type III 

 
Figure 1.1-15: Type IIIA of Gustilo Anderson 

Classification 

 
Figure 1.1-16: Type IIIB of Gustilo Anderson 

Classification 

 
Figure 1.1-17: Type IIIC of Gustilo Anderson 

Classification 

• High energy 

• Wound size > 10 cm 

• Extensive soft tissue damage 

• Severe comminution of fracture 
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Table 1.15: Most common types of femoral shaft fracture 

Most Common Types of Femoral Shaft Fracture 

Transverse fracture [26] 

 
Figure 1.1-18: Transverse 

fracture(a)  

 
Figure 1.1-19: Transverse 

fracture(b)  

 
Figure 1.1-20: Transverse 

fracture(c)  

• The fracture line is perpendicular to the shaft of the 

femur. 

• Resulted when a strike delivers a significant amount of 

force that is perpendicular to the bone. 

• Fall under the category of complete fracture. 

Oblique fracture [28] 

 
Figure 1.1-21: Displaced short 

oblique fracture  

 
Figure 1.1-22: Long oblique 

fracture 

• The fracture line is broken through the bone at an angle 

with a curved or sloped pattern. 

• Resulted when force is applied to the bone at an angle 

other than a straight angle. 

• Can be sub-divided into short oblique and long oblique 

[25]. 

• Short oblique: fracture line lies between 30 

degrees and 60 degrees from the bone’s long axis 

• Long oblique: < 30 degrees in relation to the 

bone’s long axis 

• Fall under the category of complete fracture. 
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Figure 1.1-23: Oblique fracture  

Spiral fracture [27] 

   
Figure 1.1-24: Spiral fracture(a)  

 
Figure 1.1-25: Spiral fracture(b) 

• The fracture line is wrapping around the bone and 

forms a corkscrew shape. 

• The bone breaks from the cortex to another side of the 

cortex, then to another side of the cortex, and finally 

back to the starting point of the cortex. 

• Resulted when a bone is subjected to an extremely 

strong twisting force. 

• Spiral fracture can be complete or partial. 

Comminuted fracture [29] 

 
Figure 1.1-26: Comminuted 

fracture(a) 

 
Figure 1.1-27: Comminuted 

fracture(b) 

• The bone is broken into several pieces. 

• Usually resulted from severe traumas, such as vehicle 

accidents and falls from great heights. 

• Fall under the category of complete fracture. 

The types and classifications of fractures can be reviewed and revised by surgeons to apply the 

most suitable treatment for their patients. The treatments involve open reduction and closed 

reduction. For most serious and complicated cases, open reduction and internal fixation (ORIF) 

is applied, while a mild fracture or fracture on children is usually applied with closed reduction, 
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such as traction and casting. Internal fixation is always done with the technique of 

intramedullary nailing (IM nail), which is made up of the implantation of a metal rod, screw, 

or plate into the medullary cavity of the bone to provide resolute support for the broken bone. 

IM nail has also become the “gold standard” for treating femoral shaft fractures because it 

resulted in a short hospital stay, fast fracture union, and early functional use of the limb [36]. 

However, it is sometimes difficult for surgeons to apply the IM nail technique for some rare 

and complicated cases such as the bending shape of the femur and the diameter of the bone 

medullary cavity in patients may differ from the normal according to gender as well as changes 

in age, thus, this being the cases result in a mismatch of the equipment (metal rod) with the 

femur bone. It is for this reason that the maximum-minimum centre approach associated with 

some other techniques is utilised to calculate the thickness of the patient’s bone medullary 

cavity accurately, thereby applying the most appropriate size of metal rod for them [37]. 

Femoral shaft fracture is commonly used in several research for further studies. However, there 

is currently no complete and independent platform for people to learn and focus on the human 

femur and the types of femoral shaft fractures. Therefore, in this project, an educational portal 

with a 3D interactive atlas for the human femur along with the potential femoral shaft fractures 

is to be focused on this project. There are 3 different 3D atlas applications that have been 

reviewed in this research for gathering the idea of designing the platform of the educational 

portal for human femoral shaft fractures. 

In this era of globalisation, digital technology has gradually covered the world, and education 

systems are no exception, especially in advanced countries. An educational portal has become 

significantly important since the internet is widely used by the world for learning purpose. 

Educational portal is a multi-function and informative platform designed for providing users 

the educational services [6]. It facilitates both the learners and educators because the learners 

can search for the information through the portal instead of attaching to the educators directly.  

Because of the commonly used of human femur in multidisciplinary research for the purpose 

of experimental and computer simulation works, such as orthopaedic surgery, biomechanical 

engineering, biomedical engineering, rehabilitation, and medical implant technologies, the 3D 

model of human femur is constructed using a polygonal model which created from computed 

tomography (CT) data and exported to computer-aided design (CAD) for the creation of the 

bone surface [7]. This also means that 3D atlas is essential for learners to have a better 
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visualization on the anatomy of the human femur. Learners not only need to know the structures 

and functions for the anatomy part but also the spatial relationship to the surrounding structures. 

For example, the femur is divided into 3 parts, namely proximal (upper), shaft (middle), and 

distal (bottom), also, each part of them consists of different landmarks and surfaces. With the 

complication of the human femur, the 2-dimensional (2D) illustration may consist less efficient 

for learners to study and understand the entire femur structure, inversely, 3D atlas or models 

could improve learners’ understanding as well as their imaging of the anatomy of the human 

femur. Besides, 2D illustration may need a lot of pages for showing the different capture of 

surfaces or angles of a particular anatomy in the textbook. Therefore, most of the time, the 

educators choose to teach with a plastic model in the laboratory for improving the 

understanding of learners. However, plastic models are occupying the spaces of the laboratory, 

and 3D atlas applications or platforms are then developed with the tablet and smartphone for 

learners to study anatomy more easily and interactively [8]. Besides, 3D atlas platforms also 

allow learners to study anatomy anywhere by using the tablet or smartphone.  

 

1.2 Problem Statement and Motivation 

The human femur bone is widely used for experimental and computer research; however, there 

is no independent learning platform for the human femur [7]. Besides, most of the 3D 

interactive anatomy platforms without including information on femoral shaft fractures. This 

may result in learners being unable to learn about the types and classifications of femoral shaft 

fractures through the platforms and having to search for another source to learn about it. 

Nowadays, everything goes online and is slowly replaced by technology. The 3D interactive 

anatomical atlas has also become indispensable for medical students or practitioners. However, 

the initial cost of a 3D platform or application can be expensive, and it may become a burden 

for learners [9]. This is because the use of real bone or organs for the creation of 3D models is 

costly [7]. Moreover, most medical students possess insufficient knowledge of anatomy since 

the time spent in the laboratory is less because they are only allowed to interact with the plastic 

model during class time. According to [10], there are more than half of the respondents from 

junior doctors say that there is insufficient integration of anatomy teaching in their clinical 

years. Due to this issue, most of the junior doctors possess lower confidence when they start to 

work, and this may lead to severe consequences and even the patient also distrusts them. 
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However, applications do not always provide accurate or trustworthy information compared to 

decades-old-anatomy textbooks [20]. 

Since the human femur is often employed in multidisciplinary research for different 

experiments, hence, a proper 3D model is needed to develop for reducing the cost of using the 

real bone. Besides, it is difficult to find real bone or plastic models with different types of 

femoral shaft fractures and there is currently no suitable platform for people to observe and 

understand them, hence, the need for a 3D learning platform for human femoral shaft fracture 

to be created is greater than ever. Furthermore, a 3D atlas platform is also essential for learners 

to understand and master the anatomical structure. This is because they need to provide 

accurate information and suitable treatments for the patients if their job is to be a medical 

worker. In addition, there is also research that found 3D tools are resulted in superior factual 

and spatial anatomy knowledge as compared to traditional approaches [11].  

According to the fact found, the human femur is the strongest bone in the human body, and an 

adult male femur can withstand around 6,000 pounds of compressive force, which indicates 

that the femur is hardly to suffer a break [38]. Nevertheless, it can still be broken especially in 

a high-vehicle collision. In 2011, there is a study estimated that the rate of femoral shaft fracture 

for 100,000 people yearly was between 10 and 20 [39], while in 2015, there is research found 

femoral shaft fractures result from 1 to 2.9 million road traffic collisions yearly worldwide, and 

the mean of femoral shaft fracture incidence among the low and middle-income countries was 

between 15.7 and 45.5 out of 100,000 people yearly [40]. Besides, [39] also stated that there is 

an expected climb in the overall annual rate for femoral fractures, and the estimated number of 

femoral fracture incidences tends to be doubled by the year 2050. People should start to be alert 

on what type of fractures they may suffer, causes for the femoral fractures, treatments for 

femoral fractures, precautions for getting femoral fractures, as well as what they can do if they 

suffer a femoral fracture. This has also become one of the important reasons or motivations for 

dealing with this project. 
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1.3 Objectives 

 To develop an informative educational mobile application for users to gain knowledge of 

the human femur in detail so that they can master the anatomy of the human femur easily.  

• Other than the name of structures, extra information such as potential femoral shaft 

fractures, different fracture classifications and medical treatments are also provided 

in this application. 

 To develop a better learning experience for users to learn the anatomy of the human femur 

and its potential shaft fractures. 

• Develop in the form of Android mobile application so that enable users to learn 

anatomy anywhere and anytime with a mobile device. 

• Involve interactive 3D atlas for providing users a better sight of the anatomy of the 

human femur and its potential shaft fractures. 

• Develop the function of making their own notes, whereby making easier for them 

to revise on the part of the anatomy. 

• Quizzes are built into the application for users to test their current learning levels 

along with a leaderboard. 

 To develop a completely free educational mobile application devoid of any advertisements 

so that lessen user strain from having to purchase pricey software or real bone which might 

be hard to come by. 

 

1.4 Project Scope and Direction  

The scope of this project is to develop an informative educational mobile application for human 

femoral shaft fractures which involves the 3D interactive model. The proposed educational 

mobile application is developed in the operating system of Android. There is a total of 6 types 

of bone fractures have been mentioned in the previous section; however, due to limited 

resources, only 4 of them will be presented in this application, which includes transverse 
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fracture, spiral fracture, comminuted fracture, and oblique fracture. All the types of fractures 

can be displaced or non-displaced according to the severity of injury.  

This application mainly targets normal users without any medical background but who are 

interested in learning about human femoral shaft fractures, an example is science stream 

students from high school.  Based on the Form 4 textbook, there is a chapter related to the 

skeletal systems, which is chapter 14 “Support and Movement in Humans and Animals” [59].  

Even though they may not require learning deeply about the human femur, they can always 

refer to this application for additional information if they are interested. Besides, teachers can 

also use this application to impart extra knowledge to their students during classes. Perhaps 

this mobile application is able to increase the vividness and interest of the class. 

Furthermore, this mobile application also supports offline access after downloading and 

installation. It will provide several functions that allow users to have a better sight for 

understanding the human femur as well as its potential shaft fractures with the treatments. The 

functions include allowing users to interact with the 3D bone model, such as rotating, scaling, 

cutting, and making their own notes. Additionally, there is a quiz section developed for the 

mobile application along with a leaderboard. The leaderboard feature is only available when 

users log in with an account. This mobile application is not compulsory for users to create and 

login with an account, but it is encouraged to do so for backing up their notes and quiz score 

for showing the leaderboard. 

 

1.5 Contributions 

Instead of using cadavers, a 3D interactive mobile application enables learners to view the 

structure of anatomy clearly in a comfortable environment. Besides, the price of a cadaver can 

be costly, and there is still an additional cost for maintaining the cadavers [12]. Furthermore, 

due to the short shelf lives of cadavers, the cadavers may start to decompose and become 

smelling within 1 or 2 days if without embalming chemicals [13]. Health issues are also 

mentioned as a drawback of using cadavers since embalming chemicals has been proved to 

have negative effects on human health [12]. Therefore, replacing the use of cadavers with 3D 

interactive atlas platforms can resolve the burden of cost as well as protect the learners and 

educators from harming their health. Also, it resolves the issues of plastic models that occupy 
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the space of the laboratory. Other than that, it allows learners to continue studying anatomy at 

home, which also can resolve the issue in school or university that they are only permitted to 

use and observe the plastic model during class time. The use of 3D interactive atlas platforms 

has also addressed the problem of anatomy becoming more theoretical due to hard to get the 

real anatomy models. Furthermore, nowadays, there are several 3D anatomy learning platforms 

supporting for using offline after downloading it. This has also resolved the issue of network 

unstable and enabled users to learn anatomy anywhere. Apart from that, as time goes on, the 

information involved in 3D anatomy learning platforms becomes more trustworthy and high-

quality, and hence, most learners can rely on the platforms to learn anatomy on a deeper level. 

 

1.6 Report Organization 

This report is arranged into 7 chapters, which are introduction, literature review, system 

methodology, system design, system implementation, system evaluation and discussion, as 

well as conclusion and recommendation accordingly. The content of the first chapter includes 

project background, problem statement and motivation, objectives, project scope and direction, 

and contributions. The second chapter includes review of technologies, and review of existing 

systems. The third chapter includes system methodology, system requirement, user 

requirement, and project timeline. The fourth chapter includes system design diagrams, such 

as flowchart, system architecture diagram, database architecture diagram, entity relationship 

diagram, use case diagram, and activity diagram. The fifth chapter includes software setup, 

project setting and configuration, system operation, and implementation issues and challenges. 

The sixth chapter includes overall system testing, such as testing methods, testing setup, result 

of testing, and objectives evaluation. The last chapter, the seventh chapter is all about the 

conclusion of the entire project and recommendation or future work. 
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Chapter 2 

Literature Review 
 

2.1 Review of the Technologies 

2.1.1 Firmware/OS 

There are 2 most popular and successful operating systems within the mobile field, which are 

Android and iOS. With the changing times along with the rise of high-advanced technology, 

the number of smartphone users worldwide has a rapid growth from 2 billion in the year of 

2016 to 6.7 billion in the year of 2022 [41]. According to the most current statistic in September 

2022, even though the usage percentage of Apple’s iOS is enlarging, Android currently still 

occupies most of the market share at around 72%, while iOS is only at around 28% [42]. 

However, the statistic of market share is not always a crucial consideration when creating an 

Android or iOS app. There is no clear winner when it comes to Android apps against iOS apps, 

the final decision of a company to produce an Android app, an iOS app, or even an app for both 

Android and iOS may also depend on the pros and cons of developing for each OS or resources 

they have available. The comparison between Android and iOS development is shown in the 

table below [43]. 

Table 2.1.1: Comparison between Android and iOS Development 

 Android Development 

 

iOS Development 

 
Language used • Java 

• Kotlin 

• C/C++ 

• C# 

• HTML, CSS, JavaScript 

• Python 

• Flutter, Dart 

• Corona 

• Swift 

• C# 

• Objective-C 

• Flutter, Dart 

• React Native 

• HTML5 
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Source system Open, more features that are 

restricted in iOS can be developed 

in Android 

Closed, more secure 

Fragmentation • With large number of different 

devices that can run with one 

responsive app 

• Devices may apply with the 

different version of OS 

• Most the devices use the same 

version of iOS (the OS is 

upgradable among all the 

devices) 

Testing and 

debugging 

Time consuming to test the app for 

all the version of OS for different 

devices 

Less time to spend on testing the 

app developed, and easier for 

debugging 

App publishing Easier, only takes few hours to 

progress after uploading the 

Android Package (APK) 

More difficult, as the app requires 

to first pass the high standard of 

testing 

Cost High, because there are more 

devices with different OS that need 

to be taken into consideration of 

It can also involve a high cost at 

the beginning because the IDE of 

Xcode can only be used on Macs 

 

2.1.2 Database 

The database is a storage for storing different information on an application or website.  

Information types to be stored may include text, images, and documents.  A database enables 

users to store their information persistently and to readily alter the data as they wish to.  The 

database is divided into different categories, such as storing data locally (offline) or in a cloud 

(online). There are some considerations to choose suitable databases for storing data of an 

application or website, such as the structure of data, size of data, data model flexibility, 

database and platform support, scalability and speed, as well as data security [45].  
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Table 2.1.2-1: Comparison of Local Storage and Cloud Storage [53], [54] 

 Local storage Cloud storage 

Characteristics • Store data or information on-

premise, such as in physical 

storage devices 

• Internet connection is not 

needed for assessing data in 

local storage 

• Data or information can be 

accessed over the internet 

connection 

Data stored in • Hard drive 

• Flash drive 

• Local file server 

• Network Attached Storage 

drive (NAS drive) 

• Online spaces with multiple 

servers 

Pros • Speedy as it need not 

internet connection 

• Security support as data can 

only be accessed by the 

devices’ owner 

• Allow storing large amount 

of data with more capacity 

easily by using larger 

capacity of physical storage 

device 

• Cheaper for storing data as it 

is not needed for purchasing 

several external drives 

• More secure as the 

application of encryption 

algorithms that only those 

authorized personnel can 

access the data 

• Easier to access the data at 

anywhere as it is stored 

online 

• Support backing up data 

when the physical storage 

device is not accessible 

• Support file syncing when 

making every change 
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Cons • Data can only be accessed 

through the physical storage 

devices 

• The cost for purchasing 

physical storage devices can 

be high 

• Unable to access the data 

stored in physical storage 

device anymore if it is 

damaged or being stole 

• The internet speed may 

affect the experience for 

accessing the data 

• The cloud server may be 

down sometime. 

 

Table 2.1.2-2: Description and Characteristics of Databases 

Database Description and Characteristics 

Firebase [46], [52] 

 

• A backend as a service (BaaS)-based mobile and online 

app development platform sponsored by Google 

• A cloud-based NoSQL database 

• Possesses of authentication libraries that allow 

establishing of a functional authentication process with 

lesser time and fewer lines of code 

• Support real-time database 

• Support storing data and information on cloud 

• Support Google analytics 

• Great for real-time changes and data management 

SQLite [47], [48] 

 
 

• Lightweight 

• A software library that provides Relational Database 

Management System (RDBMS) 

• Database files are stored on disk 

• Does not require a server for operation  

• With limited database size 
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MySQL [49], [50] 

 

• Type of RDBMS 

• Provides higher security as it possesses of a strong data 

security layer to keep critical information safe from 

intruders and passwords are encrypted 

• Compatible with many other operating systems, such as 

Windows, Linux, and UNIX 

• Does not require much RAM 

• Support integration of different programming language 

• Not particularly effective when dealing with large 

databases 

MongoDB [51], [52] 

 

• Type of documented-oriented NoSQL database 

• Can be operated on-premises or in the cloud 

• Highly secure 

• Provides better performance in dealing with high volume 

data storage 

• Does not restricted by schema and is flexible to store any 

type of data 

• Support powerful search and indexing tools 

• Provides better performance as compared to traditional 

RDBMS 

• The feature of replication brings better stability and data 

availability 

• Memory usage may be inefficient when there are several 

data to be replicated 

• Great for quick data management 

 

2.1.3 Programming Language 

Since this project is planned to be developed as an Android mobile app, there will be some 

top languages for Android development to be reviewed. The languages include Java, Kotlin, 

C/C++, C#, Python, HTML, CSS, JavaScript, Dart, and Corona [44]. 
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Table 2.1.3: Description and Characteristics of Programming Languages 

Programming Language Description and Characteristics 

Java 

 

• Official language for Android app development before 

the Kotlin 

• Most supported language by Google 

• Consists of superb online community where developers 

can go for support easily if they encounter any issues 

• May be a complicated language for beginner to use 

Kotlin 

 

• Replace Java to be the official language for Android app 

development since 2019 

• Cross-platform programming language 

• Can interoperate with Java 

• Remove unnecessary features of Java 

• Null pointer exceptions 

• Semicolon ending in each of the line of code 

• Simpler than Java 

C/C++ 

 

• Android app development with Android Native 

Development (NDK) 

• Android app cannot be entirely developed in C++, but 

NDK can be used to implement portion of the app 

• More difficult to set up and much less flexible 

• May lead to more bugs 

C# 

 

• Similar to Java 

• Consists of cleaner and simpler syntax than Java 

• Use .NET framework 

• With Xamarin that applied with C# and .NET 

framework, Android tools may be used to create native 

Android applications and share the code between 

different platforms 
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Python  

 

• Python is not natively supported by Android; however, a 

number of tools can be used to transform Python 

applications into Android Packages, for example, an 

open-source Python library namely “Kivy” is mainly 

used for developing mobile application. 

HTML, CSS, JavaScript 

 

• Android apps can be developed using Adobe PhoneGap 

framework that is powered by Apache Cordova 

• Very little or no programming is needed, with the 

exception of JavaScript 

Dart 

 

• Powered by Flutter framework 

• Designed by Google to be a client-optimized language 

for quick apps on any platform 

• Focuses on facilitating UI development for developers 

with tools like hot-reload, which allows them to see 

changes immediately as they are being made to the 

application 

Corona 

 

• A software development kit can be used for developing 

Android apps using Lua 

• Corona Simulator: used to develop apps directly 

• Corona Native: used to integrate Lua code with Android 

Studio project to develop native feature-rich apps 

• Primarily used to create graphics apps and games 

• It has some limitations as compared to Java, but it is 

considerably simpler and has an easier learning curve 

 

2.1.4 Summary of the Technology Review 

In conclusion, this project is going to develop on the Android platform because the initial cost 

for developing an iOS application is high, which requires to use IDE of Xcode that only 
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available for Macs. Besides, there are some databases that have been reviewed, which include 

local and cloud storage. This project is only required to store some lightweight data, such as 

some texts for users to take some notes, and quiz score data. To prevent data loss and content 

unavailable when internet is not available, PlayerPrefs has been used to store the data locally, 

meanwhile, Firebase is applied for allowing users to retrieve their data while using another 

device with the same login account. PlayerPrefs acts as a scripting API in Unity that can be 

used in this project with ease for preserving permanent data in Unity, while Firebase is a cloud-

based database that can store all the data in the cloud rather than on-premises. Since this project 

is planned to develop a mobile application that allows users to use it on multiple devices, the 

authentication libraries that are supported in Firebase have made it easy to identify users. With 

the backend services and SDKs, it allows saving users’ information in the cloud and permitting 

them to retrieve the same data across different devices. Lastly, because the C# programming 

language is natively supported by Unity, it has been chosen for developing this project. Even 

though C# may not be as efficient as C++, it is easier than C++, and consists of maximum 

support, as there are a lot of resources available on the internet as compared to other 

programming languages.  

 

2.2 Review of the Existing Systems/Applications 

2.2.1 Anatomyka Skeleton (Source: Anatomyka, 2021) 

   
Figure 2.2.1-1 Anatomyka Skeleton Home        Figure 2.2.1-2 Anatomyka Skeleton Learning 
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Figure 2.2.1-3 Anatomyka Skeleton Color 

Anatomyka Skeleton is a 3D atlas interactive application accompanied with full human 

skeleton structures and information for users to view and learn. Anatomyka Skeleton is not 

considered a free platform since it consists of ads, and if users want to remove the ads, they 

need to pay for it. As the figures shown, the user interface of this platform is simple and clean. 

On the home page of Anatomyka Skeleton, users can click the top left button and turn into 

learning mode. After turning into the learning mode, users can isolate any part of the skeleton 

as shown in Figure 2.2.1-2. It is much easier for users to learn the landmarks of skeletal since 

there are pins in different colours. Besides, there is also a list of landmarks and descriptions 

that appear at the right-hand side of the learning page. Users can either click on the pin or the 

name of listed landmarks to learn the anatomy of the skeleton. There are also some clinical 

notes and interacting facts provided under the column of ‘brief’ after selecting one part of the 

skeleton. To view the structures clearly, users can zoom in the particular part of the skeleton. 

Moreover, the function for hiding, rotating, fading, scaling, and selecting are also allowed for 

users to manipulate the structures of the skeleton. Other than that, colours have been proven in 

a study that helps in learning and memorizing since they can increase human attention levels 

[15]. As Figure 2.2.1-3 shows, users can highlight the parts or structures of the skeleton with 

different colours which allows them to have a better learning experience. Furthermore, there is 

also a search function available in Anatomy Skeleton for users to search a particular part or 

structure of the skeleton. However, there are no notes functions provided by Anatomyka 

Skeleton. Therefore, users are not able to re-label the skeleton or make some extra notes for 

the skeleton in the platform. This may cause inconvenience for users when they are learning 

without a pen and paper.  



Bachelor of Information Systems (Honours) Information Systems Engineering  
Faculty of Information and Communication Technology (Kampar Campus), UTAR 
                                                         

24 
 

2.2.1.1 Strengths 

Anatomyka Skeleton consists of several colours of pins for landmarking the skeletal. Besides, 

it allows users to highlight or colour the different parts of the anatomy. As stated before, colour 

is useful for learning. Besides, there is extra information provided which allows users to have 

a better understanding of the particular bone. The search function developed in Anatomyka 

Skeleton is also considered as a strength for users to search the part of bone if they are not sure 

where is the part located but only know the name.  

2.2.1.2 Weaknesses 

However, Anatomyka Skeleton does not develop a function for users to make their notes, which 

is troublesome for users to use the app at the same time while referring to their own notes on 

paper or notebook. Besides, it is annoying that users need to view an advertisement video after 

using the application for a few minutes. 

 

2.2.2 Essential Skeleton 4 (Source: 3D4Medical, 2014) 

        
     Figure 2.2.2-1 Essential Skeleton 4 Home      Figure 2.2.2-2 Essential Skeleton 4 Learning 

         
  Figure 2.2.2-3 Essential Skeleton 4 Learning 2    Figure 2.2.2-4 Essential Skeleton 4 Quiz 
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Essential Skeleton 4 is a completely free 3D atlas application for human skeleton developed by 

3D4Medical for showing their new 3D technology and innovative design. Essential Skeleton 4 

provides a common skeleton knowledge for users, which is only the name of skeletal structures 

and descriptions. There is no other information provided, such as clinical notes and potential 

injuries. As Figure 2.2.2-1 shows, Essential Skeleton 4 provides several functions for users to 

learn the human skeleton. Users can click on any part of the skeleton and start to learn for the 

skeleton as shown in Figure 2.2.2-2. After clicking the part or structure of the skeleton, users 

can choose to hide, fade, or isolate the skeleton. As in Figure 2.2.2-3, if users choose to isolate 

the part of the skeleton, there will be different surfaces to be shown to the users. Besides, users 

are also allowed to rotate the skeleton at different angles as they like. Similar to Anatomyka 

Skeleton, it allows user to zoom in the anatomy. Moreover, users can also type some notes for 

the part of the skeleton. However, there are no descriptions and labels of the landmarks 

provided for the particular part of the skeleton that may cause insufficient knowledge learned 

by the users. Even so, users can utilise the pin function to label the landmarks of the part of the 

skeleton, but the possibility for users to label the wrong name is high. Other than that, users 

can also test their learning level by doing a quick quiz after setting up the study area and type 

of quiz. There are 2 types of quizzes provided by Essential Skeleton 4, which include drag and 

drop as well as multichoice. Similar to Anatomyka Skeleton, there is also a search function 

involved in Essential Skeleton 4. Furthermore, can also bookmark the part of structures that 

they like, and this allows them to look back at the information easily. 

2.2.2.1 Strengths 

Essential Skeleton 4 is a fully free educational application and comes along with a strong notes 

function that allows users to add some extra text and pins rather than only read the information 

shown on the label. Besides, there are quizzes available for users to test their knowledge level.  

2.2.2.2 Weaknesses 

Even though there are strong features included in Essential Skeleton 4, there are also some 

weaknesses that it does not provide labelling for each part of the bone. This is not friendly for 

users who wish to learn and understand each part of the bone better. Essential Skeleton 4 was 

also developed without providing extra information on the bone for users to learn. Therefore, 

it is considered a not very informative educational application.  
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2.2.3 Complete Anatomy 2022 (Source: 3D4Medical, 2021) 

     
         Figure 2.2.3-1 Complete Anatomy 3D Atlas    Figure 2.2.3-2 Complete Anatomy CT Scan 

  
Figure 2.2.3-3 Complete Anatomy Videos  Figure 2.2.3-4 Complete Anatomy Lectures 

  
Figure 2.2.3-5 Complete Anatomy Skeleton  Figure 2.2.3-6 Complete Anatomy Learning 
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Figure 2.2.3-7 Complete Anatomy Modeling 

Similar to Essential Skeleton 4, Complete Anatomy 2022 is the latest version of the 3D 

anatomy platform developed by 3D4Medical, but it is not free. It is widely recognized as the 

most functional 3D anatomy platform and is designed for remote learning and teaching 

purposes. Moreover, it consists of more than 17,000 structures of human anatomy and provides 

wonderful and complete features for users to study thoroughly on anatomy. There are also 

several functions and information included in this platform. 

Other than interacting with anatomy, Complete Anatomy 2022 also provides several lectures 

and videos in the library. As Figure 2.2.3-1 shows, there are several human anatomy 3D atlas 

models provided. Users can search and choose which part of anatomy they want to learn, either 

the whole anatomy model or only part of it. After selecting a model, there will be several labels 

shown around the model, and users can click on the label or the surface of the model to view 

the description as shown in Figure 2.2.3-6. If users choose to learn the complete skeleton, there 

will be different information shown for users to read and learn, such as the basic description, 

features, and functions. It also contains the details for the parts, surfaces, and landmarks of the 

anatomy. Besides, there is also some videos included for treatments, conditions, exercises, and 

stretches for the chosen structure of the anatomy.  

Furthermore, to disable the label around the model, users can inactivate the icon of labelling 

by clicking on it. Other than that, Complete Anatomy 2022 is so powerful that allowing users 

to make their own model by using the tools provided as shown in Figure 2.2.3-7. Not only for 

drawing and sketching, but it also provides tools for cutting the model of anatomy. After 

completing designing a new model, they can save the screen for further studying. Also, 

Complete Anatomy 2022 enables users to view and compare the CT scan and 3D model 
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parallelly on the same screen. Furthermore, AR mode and muscle motion are also supported in 

Complete Anatomy 2022. 

2.2.3.1 Strengths 

Complete Anatomy 2022 is a very powerful and comprehensive educational application for 

users to gain sufficient knowledge. It is powerful that advanced tools developed for allowing 

users to create their own models, add labels and add textbox as their notes. Besides, there is a 

lot of extra information and videos included in the application for users to study the bone. As 

for the current trend, it also supports AR. Not only that, but there are a lot of teaching resources, 

such as courses and radiology for users to gain a deep level of knowledge. 

2.2.3.2 Weaknesses 

However, Complete Anatomy 2022 is costly to use, and there is no function for users to test 

their knowledge level. 

 

2.2.4 Summary of the Existing Systems and Proposed System 

Table 2.2.4 Comparison between the reviewed systems and proposed system  

        Systems 

 

Functions 

Anatomyka 

Skeleton 

Essential 

Skeleton 4 

Complete 

Anatomy 2022 

Proposed 

system 

Interactive ✓ ✓ ✓ ✓ 

Allow for 

making own 

notes 

✗ - Can add 

some extra 

notes by 

typing in the 

label 

- Can add 

extra pins 

for doing 

own notes 

- Can make own 

model 

- Can add label 

and textbox 

✓ 
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Description 

and labelling 
✓ ✓ ✓ ✓ 

Extra 

information 

provided  

- Clinical 

notes 

- Facts 

✗ - Clinical notes 

- Facts 

- Treatments 

videos 

- Condition 

videos 

- Exercise videos 

- Stretches 

videos 

✓ 

Femoral shaft 

fractures 

information 

✗ ✗ ✗ ✓ 

AR support ✗ ✗ ✓ ✗ 

Quiz provided ✗ ✓ ✗ ✓ 

Allow 

highlighting 

the part of 

anatomy 

✓ ✗ ✗ ✓ 

Offline 

available 
✓ ✓ ✓ ✓ 

Cost Free, but consists 

of a lot of 

advertisements 

Free Costly Free 

 

In a nutshell, the 3 reviewed systems consist of similar functions, and owning with different 

strengths and weaknesses. Based on the strengths and weaknesses of each of the reviewed 



Bachelor of Information Systems (Honours) Information Systems Engineering  
Faculty of Information and Communication Technology (Kampar Campus), UTAR 
                                                         

30 
 

applications, providing sufficient information on the anatomy is essential for attracting more 

people to use the platform as it is worth the most in an education platform. Besides, making 

their own notes is also important for users to have a better understanding of the anatomy. 

Neilson also stated several tips for effective studying anatomy, and one of them is making clear 

notes [18]. Hence, adding more functions to the note page, such as adding text, adding pins, 

adding labels, drawing, and importing pictures are preferable for users to make their own notes. 

Other than making notes, the function of importing pictures allows users to import a 2D 

anatomy picture for comparing between 2D and 3D anatomy, thereby having a well 

understanding of the actual position of the part of the anatomy. Besides, since colours can catch 

the attention of the human brain, the highlighting function can also be integrated into the note 

page. This is because colours are important for stimulating users’ memory, thereby allowing 

them to absorb the knowledge better. Moreover, the feature of quizzes or exercises also acting 

an important role for users to practice and test their current knowledge and provide chances to 

correct themselves if they are doing wrong. This is because people will usually learn more 

when they make mistakes. 

 

2.2.5 Effects of using Mobile Application for Medical Education 

Since the 1990s, mobile devices have been employed extensively in the digital age. At that 

time, there were 11 million users, and the number increased to an astonishing 2.5 billion in the 

year 2020 [55]. In the Covid-19 era, the development of mobile apps is also a growing trend in 

the education sector. Statista reports that the education sector is just behind the business and 

gaming categories in terms of popularity among mobile app categories worldwide [56]. 

Besides, medical education is also greatly aided by mobile applications, especially for 

healthcare professionals and students during their training and practice. Mobile application for 

medical education is deemed effective by [57] after gathering the most keywords from studies 

that have already been published and conducting medical subject heading (MesH) phrase 

searches across 3 major databases, which are PubMed, Cochrane library, and Scopus by 

comparing with the traditional approach. The systematic review findings in [57] support that 

the use of mobile applications in medical education can improve the skill of students or learners 

regardless of the educational topics that are covered in different mobile applications. As proof, 
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52 studies were considered, out of which 29 evaluated changes in knowledge, 10 evaluated 

changes in skill level, and 13 evaluated changes in both knowledge level and skill level. 

Mobile applications in medical education are currently employed by most researchers in the 

aspects of anatomy, surgery, respiratory conditions, dermatology, basic life support (BLS), 

pathology, dose calculation, as well as radiography. Since the mobile applications are designed 

for different topics, the built-in features will also differ accordingly, hence, the choice of users 

depends on their interests or professions. However, most of the mobile applications developed 

were web-based, and there is no offline support. Even while there is no discernible 

improvement in users’ level of knowledge or skill enhancement using the application offline 

or online, the offline capability is crucial to increasing the users’ acceptance and use of mobile 

applications, especially those from middle-income countries and rural areas [57]. 

By taking into account the low cost, increased versatility, reduced reliance on regional or site 

borders, online and offline capabilities, simulation capabilities, and ability to be used 

anywhere, mobile applications can be seen as an excellent supplementary tool in medical 

education [57].  
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Chapter 3 

System Methodology/Approach OR System Model 
 

3.1 System Methodology 

A suitable system development methodology must be identified before starting to develop a 

system. Since this is a from zero design system, the requirements may not be clear enough, 

therefore, the methodology chosen for developing this project is the prototype model. The 

prototype model is a methodology that allows a prototype to be developed with minimal 

specifications where it then will be tested and modified according to the feedback from the user 

[19]. Besides, it can ensure the system requirements are met because the phases of design, 

prototyping, and evaluation phases are repeated unless the user is satisfied with the prototype 

designed.  

 
Figure 3.1: Methodology of Proposed System 

Stage 1: Requirements Gathering and Analysis 

First of all, the first task included in this project is identifying the user requirements, whereby 

the users or project owners are interviewed to understand what their expectation from the 

system is. By understanding the user requirements, the project scope can also be identified. 

Next, project feasibility is studied during this phase, which involves the technical, estimated 

cost, and profit of the project. If the project is fine for all, then it will come to the next stage. 

Stage 2: Design, Prototyping and Evaluation (quick design) 
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In stage 2, the design, prototyping, and testing phase are interleaved. An initial design of the 

system will be able to generate and come out with a prototype during the early stage 2. The 

prototype is for project owners to simulate with realistic software to ensure that the 

requirements are met and for evaluation. Usually, there will be additional requirements or 

requirement changes from the project owners. Then, another prototype will be developed for 

enhancement according to the feedback for project owners to simulate and gain again new 

feedback from them. These 3 phases are basically repeated until the project owners are satisfied 

with the system. 

Stage 3: Implementation and Maintenance 

The final system will be fully tested by both the developers and project owners. This is to 

ensure the system is performing well without any error as well as meets user requirements. 

Once passed through the testing phase, the system is ready to implement. After all is done, the 

maintenance phase may be carried out if there is any issue with the developed system. 

 

3.2 System Requirement 

3.2.1 Hardware 

The hardware needed for completing this project involve a laptop and an android mobile 

device. A laptop is needed for develop a mobile application which support for the interactive 

3D objects, while the android mobile device is needed for testing once the system is completed 

deployed. There are some specifications of laptop for developing the system: 

Table 3.2.1 Specifications of Laptop 

Description Specifications 

Model Victus by HP Laptop 16-e0xxx 

Processor AMD Ryzen 5 5600H with Radeon Graphics @ 3.30 GHz 

Operating System Windows 11 

Graphic NVIDIA GeForce GTX 1650 

Memory 16GB DDR4 RAM 

Storage 512GB SATA SSD 
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3.2.2 Technologies Involved 

Table 3.2.2 Tools and Software 

Tools / Software Description 

Unity  

 

Unity is a cross-platform game engine that is currently 

commonly used in developing video games. It supports both 

the 2D and 3D environments for PC and mobile 

development. The native programming language used in 

Unity is C#. It will be used as the main development tool 

for developing the 3D educational mobile application for 

femoral shaft fractures. 

Visual Studio 2022 

 

Visual Studio 2022 is an IDE mainly for the purpose of 

coding, and there are several languages supported in it, such 

as C#, C++, Python, Node.js, and others. It also can be used 

to develop mobile apps, websites, web apps, web services, 

and computer programs. It will be used for coding the 

scripts for making the mobile application function well. 

Blender 

 

Blender is a free and open-source software for 3D 

environments, such as modelling, rigging, animation, 

rendering, compositing, motion tracking, as well as video 

editing. It will be utilised for modelling the types of fracture 

bones. 

C# programming language 

 

C# is natively supported by Unity, and with Visual Studio 

2022, some user-interaction features of the mobile 

application will be programmed in C#. 

  
Firebase 

 

Firebase is a NoSQL cloud-hosted database that is used to 

store, sync, and query app data on a large scale. It will be 

used to sync data from PlayerPrefs and store it in the cloud 

to prevent data loss in the event that the application is 

removed or reinstalled. 
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3.3 User Requirements 

3.3.1 Functional Requirement 

 3D Model interaction 

The educational application should allow users to interact with the 3D model, such as 

touching, rotating, and scaling. 

 Notes 

The educational application should allow users to add text for doing extra notes rather 

than view the information provided. 

 Quiz sections 

The educational application should allow users to take some quizzes or exercises for 

knowledge testing and consolidating their learning. 

 Video playing 

The educational application should allow users to play educational videos for gaining 

extra knowledge and enhance their understanding. 

3.3.2 Non-Functional Requirement 

 Reliability 

The educational application should be reliable and provide high quality and accurate 

information. Besides, updating it if any information is being modified. 

 Usability 

The user interface of the educational application should be intuitive and easy to use, 

whereby the users will get how to use the application at a glance. 

 Performance 

The educational application should be quick responsive and allow offline usage. 
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3.4 Project Timeline 

3.4.1 Project I Timeline 

 
Figure 3.4.1-1: Timeline - Project I (Part 1) 

 
Figure 3.4.1-2: Timeline - Project I (Part 2) 



Bachelor of Information Systems (Honours) Information Systems Engineering  
Faculty of Information and Communication Technology (Kampar Campus), UTAR 
                                                         

37 
 

3.4.2 Project II Timeline 

 

Figure 3.4.2: Timeline - Project II 
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Chapter 4 

System Design 
4.1 System Design Diagram 

4.1.1 Flowchart 

 

Figure 4.1.1-1: Flowchart - Part 1 
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Figure 4.1.1-2: Flowchart - Part 2 

Figure 4.1.1-1 and Figure 4.1.1-2 represent flowchart that shows how the app will function. 

The diagram clearly shows the flow of the application, which the users will allow to choose 

the menu and study the related information on human femur bone fracture. Users are allowed 

to interact with the bone, read information, and add extra notes accordingly. To gain more 

understanding, users can read general information and watch related videos by selecting the 

menu. Also, the quiz section will only end if users answer all the questions. All the data will 

then be synchronised from and to a cloud if users sign in with an account.  
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4.1.2 System Architecture Diagram 

 
Figure 4.1.2: Architecture Diagram 

Profile Module:  

• Users can register a new account. 

• Users can log in with their own account. 

• Users can modify/delete their profile. 

Quiz Module: 

• Users can start the quiz game. 

• Users can check their ranking through the leaderboard feature. 

Bone Module: 

• Users can interact with different bone models, such as rotating and scaling. 

o There is also a cutting feature for intact femur bone, which allows users to get 

some ideas about the inner part of bone. 

• Users can interact with the intact femur bone and inner part of femur bone to get to know 

the name of each part of the bone structure. 

• Users can read information regarding each of the types of bone. 

• Users can add and save their notes as text for each of the types of bone. 
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• Users can resize and drag the pop-up windows of information and notes panel. 

Learning Module: 

• Users can play videos from different categories (types and classification, complication, 

treatment). 

• Users can read additional information regarding the human femoral shaft fractures. 

o Information includes text and images.  

The proposed system is to be developed as a 3D educational mobile application that includes 

4 main modules, which are bone module, profile module, quiz module, and learning module, 

where the learning module is involving different categories of video lists and provide extra 

information with text and images for users to read. All the features will remain works even if 

users do not sign in with an account, except the leaderboard feature (under quiz module) and 

synchronise notes and quiz score into cloud. As mentioned previously, this application also 

supports offline usage, which means that users still can save their notes locally in their mobile 

device, same goes for the quiz score. The highest quiz score will be automatically saved locally 

in users’ mobile device if they finish a quiz. Once they register and logged in with an account, 

all the local data will automatically upload to the cloud if the internet is available. The reason 

to develop this application with a cloud database is mainly to minimise the risk of data loss and 

make ease on data retrieving among different Android devices. 
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4.1.3 Database Architecture Diagram 

 
Figure 4.1.3: Database Architecture Diagram 

Figure 4.1.3 shows the database architecture diagram. Users can retrieve data locally if the 

internet is unavailable. Users can still save their notes and quiz data locally by utilising the 

PlayerPrefs class provided by Unity. On the other hand, if the users are back online, the data 

can be synchronised manually and uploaded to the cloud database as a backup. If the data in 

the cloud is the newest version, the data will be retrieved from the cloud and replaced with the 

local instead of uploading the local data to the cloud. Besides, users can also get realtime data 

or live data if there is another device that is connecting to the same account and is currently 

editing the data. As a result, the risk of data loss can be minimised and it allows users to use 

other Android devices for continuing their learning state. 
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4.1.4 Entity Relationship Diagram 

 
Figure 4.1.4: Entity Relationship Diagram 

There is only a simple database involved in this proposed system. The main entities are user, 

notes, and quiz. A user can add text as notes for different types of bone fractures, an intact 

femur bone, as well as inner part of human femur bone. Besides, a user has the highest quiz 

score as 0 by default after registration until they start a quiz and get a higher score.  
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4.1.5 Use Case Diagram and Description 

 
Figure 4.1.5 Use Case Diagram 

Figure 4.1.5 shows how the users can interact with the application, whereby the users can 

interact with the bone models for having a better view of the bone structure. While studying, 

they can also read the information of each of the bone models and add extra notes. Besides, 

users can learn extra information by reading the general information and watching videos. 

Additionally, they can test their knowledge by attempting the quiz section. 
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4.1.6 Activity Diagram 

4.1.6.1 Intact Femur Bone Activity Diagram 

 
Figure 4.1.6.1: Activity Diagram - Intact Femur Bone 

 
Figure 4.1.6.1 shows the activity flow of the intact femur bone module. The users can interact 

directly with the bone, such as scaling, rotating, and cutting. While users interact with the 3D 

object of the femur bone, there are labels for different parts or structures of the bone. Then, text 

information is available for users to decide whether to read through. The users can also decide 

to add extra notes if they wish to. After adding text as extra notes, the notes then can be stored 
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inside the local database. If users are logged in with an account and is connected to the internet, 

the notes will automatically be saved and upload to the cloud. 

4.1.6.2 Fracture Femur Bone Activity Diagram 

 

Figure 4.1.6.2: Activity Diagram - Fracture Femur Bone 
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Figure 4.1.6.2 shows the activity flow of the fracture femur bone module. The users can select 

any type of fractured bone that they wish to learn about, then interact with the bone. After that, 

same as in the previous module, users can decide if to read the text information or not. Then, 

decide to add text as extra notes. If users are logged in with an account and is connected to the 

internet, the notes will automatically save and upload to the cloud. 

4.1.6.3 Quiz Activity Diagram 

 
Figure 4.1.6.3-1: Activity Diagram - Quiz (Part 1) 
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Figure 4.1.6.3-2: Activity Diagram - Quiz (Part 2) 

Figure 4.1.6.3-1 and Figure 4.1.6.3-2 show the flow of the quiz module. Firstly, the system will 

check if the users have answered all the questions, if they are not, the system will continuously 

check whether the users had answered the correct answer. If yes, scores will be added, else 

there will be an explanation shown to users. Once the users have done all the questions, the 

system will then check whether it is the first time the users started the quiz. Before displaying 
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the result to users, it will check if the user has logged in and the internet is available. If the 

internet is available, it will then upload the highest score to the cloud. 

4.1.6.4 Account Registration Activity Diagram 

 

Figure 4.1.6.4: Activity Diagram - Account Registration 

Figure 4.1.6.4 shows the flow of account registration. Users can register an account with their 

email, username, and password. To ensure the password entered by the users is correct, there 

is another field that requires the users to re-enter their password for confirmation. If the email 

entered is valid, and both the password and confirm password match, the account will be 
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registered successfully and turned back to the login page automatically. On the other hand, if 

any of the information entered is invalid, an error message will display. 

4.1.6.5 Login Activity Diagram 

 

Figure 4.1.6.5: Activity Diagram - Login 

Figure 4.1.6.5 shows the login flow. Users require to enter their email and password that have 

been registered previously. If the email and password are valid, the users will be able to login 

to the system successfully, or else, the error message will be displayed. 
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4.1.6.6 Forgot Password Activity Diagram 

 

Figure 4.1.6.6: Activity Diagram - Forgot Password 

Figure 4.1.6.6 shows the flow of forgotten passwords when logging in to the system. If the 

users had forgotten their password, they can easily reset their password by entering their 

registered email. Then, the system will send a link to the users’ email, and they can reset their 

password by clicking on the link. 
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4.1.6.7 Profile Modification Activity Diagram 

 

Figure 4.1.6.7: Activity Diagram - Profile Modification 

Figure 4.1.6.7 shows the flow of profile modification. Users can modify or update their profiles 

after registration. Information that can be modified includes username, email, and password. 

Users are required to enter their account password if they wish to update their login email 

address to another. Besides, users have to enter their current password, new password, and new 

password verification if they want to update their password. If the information entered is valid 

and accurate, the information will be successfully updated. Furthermore, users can also choose 

to delete their account by entering the account password if they find that the account is no 

longer in use. 
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4.1.6.8 Video Playing Activity Diagram 

 
Figure 4.1.6.8: Activity Diagram - Video Playing 

Figure 4.1.6.8 indicates the flow of video playing. While users play a video from the video list, 

they can always decide whether to play in fullscreen mode or minscreen mode. Besides, users 

can pause the video anytime and unpause it again if needed. 
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Chapter 5 

System Implementation 
 

5.1 Software Setup 

5.1.1 Unity Installation 

Step 1: Download Unity from https://unity.com/download#how-get-started  

 
Figure 5.1.1-1: Download UnityHub 

Step 2: Agree with License and Install UnityHub 

    
      Figure 5.1.1-2: Agree with the License     Figure 5.1.1-3: Install UnityHub 

https://unity.com/download#how-get-started
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Step 3: Open UnityHub and Install Editor 

 
Figure 5.1.1-4: Select Editor Version to be Installed 

 
Figure 5.1.1-5: Select Module to be Installed 

Step 4: License Activation 

 
Figure 5.1.1-6: Select Manage Licenses 
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Figure 5.1.1-7: Sign In 

 
Figure 5.1.1-8: Add New License 

 
Figure 5.1.1-9: Activate Free Personal License 
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5.1.2 Visual Studio 2022 Installation 

Step 1: Download Visual Studio Community 2022 from 

https://visualstudio.microsoft.com/vs/  

 
Figure 5.1.2-1: Download Visual Studio Community 2022 

Step 2: Install Visual Studio Installer 

 
Figure 5.1.2-2: Select Continue and Agree with the License Terms 

Step 3: Select and Install Workloads 

 
Figure 5.1.2-3: Choose the Workloads to be Installed 

https://visualstudio.microsoft.com/vs/
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5.1.3 Blender Installation 

Step 1: Download Blender from https://www.blender.org/download/  

 
Figure 5.1.3-1: Download Blender 

Step 2: Install Blender 

   
   Figure 5.1.3-2: Click “Next”             Figure 5.1.3-3: Agree with the License Term 

https://www.blender.org/download/
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Figure 5.1.3-4: Browse Location for          Figure 5.1.3-5: Install Blender 

Blender Installation 

5.2 Setting and Configuration 

5.2.1 Linkage between Software 

 
Figure 5.2.1-1: Relationship among the Software 

After installing the software needed (Unity, Visual Studio 2022, Blender), Visual Studio 2022 

is required to be linked with Unity for scripting the functions of the application, while Blender 

is used to create 3D bone model. The steps for linking the Unity and Visual Studio 2022 are as 

follow:  

1. Open Unity Editor 

2. Go to Edit > Preferences > External Tools 

3. Set the External Script Editor as Visual Studio Community 2022 
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Figure 5.2.1-2: Linkage between Visual Studio and Unity 

Before developing the application, 3D models of the bones should be prepared, where Blender 

had been chosen for creating the models in this project. After the models are created, the models 

are exported to the Unity project as .fbx file. The steps of exporting the models are as follow: 

1. In Blender, go to File > Export > FBX 

2. Select Unity project folder (In my case, I created and saved the models in a folder named 

“bones” in the “prefabs” folder of the Unity project. To only export the models, I ticked the 

checkbox of “Selected Objects” during exporting.) 
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Figure 5.2.1-3: Export models from Blender to Unity 

5.2.2 Device Simulator Setup 

Besides, since this project is going to be developed on mobile platform, a device simulator is 

needed to test if the application is work in different mobile devices. The steps to install the 

device simulator in Unity are as follow: 

1. Go to Window > Package Manager 

2. Choose “Unity Registry” 

3. Look for “Device Simulator” 

4. Go to “Advanced > “Show preview packages” (if “Device Simulator” not found) 

5. Install it, then the simulator option should appear in “Game” 

(In my case, I already installed, hence, it shows “up to date” rather than “install”) 
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Figure 5.2.2-1: Installation of Device Simulator 

 
Figure 5.2.2-2: Simulator Option Appeared 
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5.2.3 PlayerPrefs Setup 

Since this project will first save data in PlayerPrefs locally in the device, developer may have 

to preview the data save and ensure the data is stored accurately. PlayerPrefs is saved as the 

file format of .xml in different locations according to different development. This may cause 

inconvenience to preview data saved during the development process, therefore, there is 

another way to preview the data easily by installing a free plugin in Unity. PlayerPrefs Editor 

us a useful plugin that allows developer to add and delete PlayerPrefs by a simple click, and 

even edit the PlayerPrefs value. Besides, it also allows data preview data in a more convenient 

way with the features of sorting, watch data changes during runtime, and data refresh. 

Following are the steps to install and use the plugin: 

1. Go to Windows > Asset Stores 

2. Search “PlayerPrefs Editor” through the search bar and install the one that had been circled 

with red rectangle. 

3. PlayerPrefs Editor then can be found in Tools > BG Tools > PlayerPrefs Editor 

4. Then, there will be a small window appear after clicking on the PlayerPrefs Editor.  

 
Figure 5.2.3-1: Search and Install PlayerPrefs Editor 
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Figure 5.2.3-2: PlayerPrefs Editor Window 

 

5.2.4 Firebase Setup 

In this project, Firebase plays an important role for users to store data on the cloud. Below are 

steps to setup the Firebase for this project: 

1. Go to Firebase console: https://console.firebase.google.com/u/0/  

2. Add new project for Firebase. 

3. Give a name for the Firebase project. 

4. Uncheck Google Analytics and create a project. 

5. Click into the created project, select “Unity” to add Firebase to the Unity app. 

6. In Unity project, go to Edit > Project Settings 

7. Select “Player” from the menu, scroll down and get “Package Name” from 

“Identification”. 

8. Back to Firebase project in the browser, paste the package name to register an Android 

app. 

9. Then, move to the next step to download the “google-services.json” file and put it under 

“Assets” of the Unity project. 

https://console.firebase.google.com/u/0/
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10. Next, follow the steps to download and unzip the Firebase Unity SDK file, and import 

those needed packages into the Unity. For instance, Firebase Auth and Firebase Database 

are the only 2 packages used in this project. 

11. Create a script to initialise the Firebase. The important code to test the availability of 

Firebase is in Awake() method. Once it is available, it will call the method of 

InitializeFirebase(). 

12. Attach it to the GameObject of “DBManager” in Unity project. 

[It is not necessary to be named as “DBManager”] 

13. Run the project, the information in InitializeFirebase() shown in the console, which means 

it works and done setting up the Firebase in Unity project. 

 
Figure 5.2.4-1: Create A New Firebase Project 

 
Figure 5.2.4-2: Name the Firebase Project 
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Figure 5.2.4-3: Uncheck Google Analytics and Create Project 

 
Figure 5.2.4-4: Create Unity App 
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Figure 5.2.4-5: Get Package Name from Unity Project 

 
Figure 5.2.4-6: Register App with the Same Package Name  
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Figure 5.2.4-7: Download Config File and Put under Assets Folder of Unity Project 

 
Figure 5.2.4-8: Download Firebase SDK and Import to Unity Project 
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Figure 5.2.4-9: Create Script to Initialise Firebase 

 
Figure 5.2.4-10: Firebase Initialised Successfully 
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5.3 System Operation (with Screenshot) 

5.3.1 Splash Screen and Sign In 

    
Figure 5.3.1-1: Splash Screen  Figure 5.3.1-2: Sign In Page 

   
   Figure 5.3.1-3: Sign In    Figure 5.3.1-4: Sign In 

Successfully (1)      Successfully (2) 
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Figure 5.3.1-1 represents the splash screen of the app. The main screen, which is the first screen 

after the splash screen is the “Intact Femur Bone” screen (as in Figure 5.3.1-3). Users are not 

necessary to sign in to use this app, it is just for the purpose of saving data into a cloud, such 

as notes and quiz scores. There is a sign in button residing in the main menu, if users wish to 

sign in, the sign in screen will show to users (as in Figure 5.3.1-2). In the sign in screen, users 

can also choose to register a new account or reset the password if they forgot their password. 

After signing in, the main “Intact Femur Bone” screen will show users a temporary message 

“Signed in as username”. Figure 5.3.1-4 shows that the username, sign out button, and sync 

button are then displayed in the main menu if the user has successfully signed in. 
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5.3.2 Sign Up 

   
Figure 5.3.2-1: Sign Up Page    Figure 5.3.2-2: Sign Up Successfully 

If users do not have an account, they can sign up for a new account if they want.  Figure 5.3.2-

1 indicates the sign up screen.  An account will be created successfully if users enter the correct 

format of email as well as both the password and confirm password are matching.  As Figure 

5.3.2-2 shows, if the account has been created successfully, there will be a message “Sign up 

successfully!  Sign in now.” prompt out, and direct the users back to the sign in screen to sign 

in. 
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5.3.3 Profile 

         
                       Figure 5.3.3-1: Profile Page   Figure 5.3.3-2: Change Username Page 

     
    Figure 5.3.3-3: Change Email Page       Figure 5.3.3-4: Change Password Page 
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If users have signed into their accounts, they are allowed to modify their profile.  Figure 5.3.3-

1 represents the user profile.  Users have the right to delete their accounts by clicking the 

“Delete Account” button.  If they wish to delete their account, they are required to re-enter their 

password for verification.  Besides, users can click the corresponding button to change their 

username, email, and password if they want. The pages for editing the profile are shown in 

Figure 5.3.3-2, Figure 5.3.3-3, and Figure 5.3.3-4. 

5.3.4 Intact Femur Bone 

         
Figure 5.3.4-1: Intact Femur  Figure 5.3.4-2: Intact Femur  Figure 5.3.4-3: Intact Femur  

Bone - Page       Bone - Labelling      Bone - Rotation 
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Figure 5.3.4-4:Intact Femur   Figure 5.3.4-5: Cut Effect    Figure 5.3.4-6: Inner Part - 

     Bone - Scaling              Page 

         
  Figure 5.3.4-7:Inner Part -  Figure 5.3.4-8: Inner   Figure 5.3.4-9: Inner 

    Labelling         Part - Rotation        Part - Scaling 
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Figure 5.3.4-10: Intact Femur  Figure 5.3.4-11: Inner Part - 

   Bone - Info and Notes      Info and Notes 

 

The figures above show features included for learning the intact femur bone. As in Figure 5.3.4-

2 and Figure 5.3.4-7, there is a label displayed when users touch the part of the bone. Users can 

also scale the bone model if they want as shown in Figure 5.3.4-4 and Figure 5.3.4-9. Besides, 

different features are available when navigating on different buttons on the right side. The four 

buttons represent information, notes, rotate, and cut accordingly for intact femur bone. In 

contrast, the fourth button for the inner part of the femur bone allows users to turn back to the 

intact femur bone model. On the other hand, there will be an effect and sound if users cut the 

intact femur bone by enabling the feature with the fourth button on the intact femur bone page 

and swiping through the bone. Figure 5.3.4f will then show to users after swiping, which is 

with the inner part of femur bone. Furthermore, when users click on the “information” or 

“notes” button, there will be a pop-up window displayed to users, which has illustrated in 

Figure 5.3.4-10 and Figure 5.3.4-11. Users can read the information and make their own notes. 

Lastly, users can click on the “rotate” button to rotate the bone model (Figure 5.3.4-3 and 

Figure 5.3.4-8).   
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5.3.5 Fractured Bone on Femoral Shaft 

The makencluded in the fractured bones are similar to the intact femur bone, the minor 

difference is only the absence of the cut feature. Below are the figures illustrating each type of 

fracture, including oblique fracture, transverse fracture, spiral fracture, and comminuted 

fracture. 

5.3.5.1 Oblique Fracture 

 
 

 

 

 

 

  

Figure 5.3.5.1-1: 

Oblique Fracture - 

Page 

Figure 5.3.5.1-2: 

Oblique Fracture 

- Rotation 

Figure5.3.1.1-4: 

Oblique Fracture - 

Info and Notes 

Figure 5.3.5.1-3: 

Oblique Fracture 

- Scaling 
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5.3.5.2 Transverse Fracture 

      
Figure 5.3.5.2-1: Transverse Figure 5.3.5.2-2: Transverse 

     Fracture - Page      Fracture - Rotation 

       
Figure 5.3.5.2-3: Transverse  Figure 5.3.5.2-4: Transverse 

 Fracture - Scaling      Fracture - Info and Notes 
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5.3.5.3 Spiral Fracture 

       
Figure 5.3.5.3-1: Spiral     Figure 5.3.5.3-2: Spiral 

Fracture - Page         Fracture - Rotation 

        
   Figure 5.3.5.3-3: Spiral   Figure 5.3.5.3-4: Spiral 

Fracture - Scaling    Fracture - Info and Notes 
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5.3.5.4 Comminuted Fracture 

       
   Figure 5.3.5.4-1: Comminuted Figure 5.3.5.4-2: Comminuted 

   Fracture - Page       Fracture - Rotation 

       
    Figure 5.3.5.4-3: Comminuted  Figure 5.3.5.4-4: Comminuted 

       Fracture - Scaling         Fracture - Info and Notes  
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5.3.6 General Information 

 
Figure 5.3.6: General Information 

Figure 5.3.6 shows the general information page, where users can read through this page to 

gain additional basic knowledge, such as the risk factors and different classifications for 

identifying and grouping the bone fractures. There are links at the bottom or end of the general 

information for users’ references. 
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5.3.7 Video 

          
 Figure 5.3.7-1: Video Lists    Figure 5.3.7-2: Video Lists    Figure 5.3.7-3: Video Lists 

  - Types & Classification        - Complication      - Treatment 

There are 3 categories for the video lists, which are types and classification, complication as 

well as treatment. This video module developed is mainly for users to deepen their learning of 

the different types of fracture knowledge. 
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5.3.8 Quiz 

                 
   Figure 5.3.8-1: Quiz -            Figure 5.3.8-2: Quiz -     Figure 5.3.8-3: Quiz -  

  Start          Questions         Explanation 

                 
       Figure 5.3.8-4: Quiz -        Figure 5.3.8-5: Quiz -      Figure 5.3.8-6: Quiz - 

   Answer Wrong         Answer Correct         Final Result 
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Figure5.3.8-7: Quiz - Leaderboard 

As in Figure 5.3.8-2, the question will be shown to users if they clicked the start button in 

Figure 5.3.8-1. The questions are displayed randomly, which means that the order of questions 

will not always be the same when users start the quiz. If users have submitted the wrong answer, 

there will be an explanation shown to users as shown in Figure 5.3.8-3. Then, it will show the 

status and current score of users with red background colour (Figure 5.3.8-4). Otherwise, it will 

show with a green background colour to represent the correct status, and score will be added 

(Figure 5.3.8-5), at the same time, update the current score at the top left corner of the question 

UI (refer Figure 5.3.8-2). Furthermore, if users have answered all the questions, the final result 

will be shown to users as in Figure 5.3.8-6. Users can also get know of their ranking number 

by clicking the “Leaderboard” button as shown in Figure 5.3.8-1, and the output would be as 

in Figure 5.3.8-7 shown. However, this feature is only available when the internet is available. 
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5.4 Implementation Issues and Challenges 

There have been numerous challenges encountered throughout the development process, 

mainly due to the use of new technologies such as Unity, Blender, and Firebase. As this project 

involves the development of a mobile application with 3D models, the user interface has been 

the most challenging aspect to tackle. For instance, adjusting the component to the desired 

aspect ratio can be difficult as the screen aspect ratio may differ across various mobile devices. 

Additionally, the order of components in Unity is crucial and requires careful consideration. A 

specific example that has caused me considerable struggle is implementing the video fullscreen 

feature. Due to the application of the grid layout group for the video list, the scripting API of 

fullscreen mode cannot directly be used. As a result, I had to invest a significant amount of 

time to understand the overall component structure in Unity to successfully implement this 

feature.  

Other than the user interface and Unity, I have also encountered issues with texturing the 3D 

model. Specifically, the texture of the “spongy bone” located on the inner part of the human 

femur bone appears strange after being applied to Unity. This issue may have arisen due to the 

undesirable baking of the texture from Blender, leading to visual differences between Blender 

and Unity.   
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Chapter 6 

System Evaluation and Discussion 
 

6.1 System Testing and Performance Metrics 

To ensure the system functions correctly before release, system testing is imperative to discover 

flaws or defects in the written code. The technique chosen for this project is typically a 

combination of white-box testing and black-box testing. Black-box testing requires no prior 

programming knowledge of the internals of the system, but only observing the correctness of 

the outputs generated by providing inputs. There will be different test cases (unit testing) 

designed for the modules developed, the purpose is to test for the functional requirements.  

On the other hand, to test the non-functional requirements, techniques such as time have been 

applied to test the responsiveness of the system. The Achievability test is also applied to test 

the ability of some features that developed in the system by repetitively doing the same action 

and then observing if the features are functioning well. A survey also served as another 

technique to test the overall non-functional requirements of this system. By collecting feedback 

through the survey, it is easy to assess how satisfied users are with the software, identify 

usability issues, and collect suggestions for improvements. All this information can then be 

used to improve the software and provide a better user experience.  

 

6.2 Testing Setup and Result 

6.2.1 Testing Setup 

6.2.1.1 Physical Device Setup 

It may be necessary to use a real device to test the touch and stylus input (such as scaling the 

bone model). Hence, Unity Remote 5 can be used in this case for testing. Following are the 

steps to setup a physical device: 

1. In Unity project, go to Edit > Project Settings 
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2. Select “Editor”, change the Device to “Any Android Device”. 

3. In the phone, download “Unity Remote 5” app from Google Play Store. 

4. In the phone, to enable developer mode. 

a. Go to Settings > More Setting > About Phone > tap Build Number for 7 times. 

[not necessary to go through this process again if the phone is previously turn on the 

developer mode] 

5. Link the phone with the laptop using USB cable. 

6. In the phone, to enable USB debugging. 

a. Go to Settings > System > Developer options > enable USB debugging 

b. Click OK 

c. Allow USB debugging 

7. Open or start the “Unity remote 5” app on phone and run the Unity project from laptop. 

 

Figure 6.2.1.1: Physical Device Setup 
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6.2.2 Result 

6.2.2.1 Profile Module 

There are different features provided in the profile module, and it will be divided into different 

tests. 

Test 1: Sign Up 

Requirements for creating a new account: 

• All the fields are required to be filled. (Email, username, password, confirmation password) 

• The input field for email should be in the correct format. 

• The password is limited to at least 8 characters, with both digits and characters. 

• Both password and confirmation password have to be matched to fulfil the registration 

requirement. 

Table 6.2.2.1-T1: Unit Testing - Sign Up 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check required 

field by not 

filling any 

data. 

1. Do not fill in 

any data. 

2. Click the 

“Sign Up” 

button. 

3. Repeat the 

steps above 

for all the 

input fields. 

N/A It should 

show an 

exclamation 

mark (“!”) 

logo beside 

the field, and 

display error 

message at 

the top of all 

the fields. 

Pass 
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2 Check email 

input field with 

wrong format 

data. 

1. Fill in a not 

email format 

text in email 

input field. 

2. Click the 

“Sign Up” 

button. 

1. abcdef@ 

2. abcef@gmail 

3. abcdegmail.com 

It should 

show an 

exclamation 

mark (“!”) 

logo beside 

the field, and 

display error 

message at 

the top of all 

the fields. 

Pass 

3 Check sign up 

status if input 

with different 

passwords. 

1. Fill in both 

the password 

and 

confirmation 

password 

with different 

input. 

Password field: 

test112233 

Confirmation 

password field: 

112233test 

It should 

show 

exclamation 

mark (“!”) 

beside both 

the password 

input fields, 

and display 

error 

message at 

the top of all 

the input 

fields. 

Pass 

4 Check sign up 

status if input 

with weak 

password. 

1. Fill in invalid 

password that 

does not 

fulfil 

requirements. 

(e.g., less 

than 8 

characters, 

without the 

1. Test12 

2. Testinggg 

3. 12345678 

It should 

show 

exclamation 

mark (“!”) 

beside the 

password 

input field, 

and display 

error 

Pass 
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characters 

and digit 

mixed) 

message at 

the top of all 

the input 

fields. 

5 Check with 

inputting all 

the valid data 

1. Input correct 

format of 

email. 

2. Input any 

username. 

3. Input the 

match 

passwords. 

4. Click “Sign 

Up” button. 

Email: 

xinmi503@1utar.my 

Username: Lam 

Password: 

UPassThis!28 

Confirmation 

password: 

UPassThis!28 

 

It should pop 

out a message 

box showing 

the success 

message and 

redirect users 

back to the 

sign in page. 

Pass 

6 Check if 

creating 2 

accounts with 

the same email 

address. 

1. Sign up again 

with the same 

email address 

with above 

test case. 

Email: 

xinmi503@1utar.my 

Username: XinMi 

Password: 

UPassThis!88 

Confirmation 

password: 

UPassThis!88 

 

It should 

show 

exclamation 

mark (“!”) 

beside the 

email input 

field, and 

display error 

message at 

the top of all 

the input 

fields. 

Pass 
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Figure 6.2.2.1-T1(4): 

Invalid Email 1 (Test 

Case 2) 

Figure 6.2.2.1-T1(5): 

Invalid Email 2 (Test 

Case 2) 

Figure 6.2.2.1-T1(6): 

Invalid Email 3 (Test 

Case 2) 

Figure 6.2.2.1-T1(1): 

Empty Email (Test 

Case 1) 

Figure 6.2.2.1-T1(2): 

Empty Username (Test 

Case 1) 

Figure 6.2.2.1-T1(3): 

Empty Password (Test 

Case 1) 
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Figure 6.2.2.1-T1(7): 

Different Password (Test 

Case 3) 

Figure 6.2.2.1-T1(8): 

Invalid Password 1 (Test 

Case 4) 

Figure 6.2.2.1-T1(9): 

Invalid Password 2 (Test 

Case 4) 

Figure 6.2.2.1-T1(10): 

Invalid Password 3 

(Test Case 4) 

Figure 6.2.2.1-T1(11): 

Valid Inputs  

(Test Case 5) 

Figure 6.2.2.1-T1(12): 

Sign Up Successful  

(Test Case 5) 
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 Test 2: Sign In 

Requirements for signing in an account: 

• All the input fields must be filled. 

• Accounts should be created before signing in. 

Table 6.2.2.1-T2: Unit Testing - Sign In 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check required 

field by not 

filling any data. 

1. Do not fill 

in any 

data. 

2. Click the 

“Sign in” 

button. 

N/A It should 

show error 

message at 

the top of all 

the input 

fields. 

Pass 

Figure 6.2.2.1-T1(13): 

Sign Up  with Same Email  

(Test Case 6) 
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3. Repeat the 

steps 

above for 

all the 

input 

fields. 

2 Check sign in 

status if using an 

email address 

that has not been 

signed up.  

1. Input an 

email 

without 

signing up 

before. 

2. Click 

“Sign In” 

button. 

aaa@gmail.com It should 

show error 

message at 

the top of all 

the input 

fields. 

Pass 

3 Check sign in 

status if enter a 

wrong password 

1. Input the 

signed up 

email 

address. 

2. Input the 

wrong 

password. 

3. Click 

“Sign In” 

button. 

Email: 

xinmi503@1utar.my 

Password: 

testing123 

It should 

show error 

message at 

the top of all 

the input 

fields. 

Pass 

4 Check sign in 

status if 

inputting all the 

correct 

information. 

1. Input the 

correct 

email 

address. 

2. Input the 

correct 

password. 

Email: 

xinmi503@1utar.my 

Password: 

UPassThis!28 

It should 

pop up a 

message 

box 

showing the 

success 

message and 

redirect 

Pass 
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3. Click 

“Sign In” 

button. 

users to the 

main page. 

     
 

 

 

 

Figure 6.2.2.1-T2(1):  

Empty Email (Test 

Case 1) 

Figure 6.2.2.1-T2(2):  

Empty Password (Test 

Case 1) 

Figure 6.2.2.1-T2(3):  

Account Not Exists 

(Test Case 2) 

Figure 6.2.2.1-T2(4):  

Wrong Password 

(Test Case 3) 

Figure 6.2.2.1-T2(5):  

Input with Correct 

Information (Test Case 4) 

Figure 6.2.2.1-T2(6):  

Sign In Successful 

(Test Case 4) 
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Test 3: Reset Password 

Requirements for resetting password: 

• Email address input field must be filled. 

• The email address should be valid. 

• The email address should be created as an account before. 

Table 6.2.2.1-T3: Unit Testing - Reset Password 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check required 

field by not 

filling any data. 

1. Do not fill 

in any data 

for the 

email 

input field. 

2. Click the 

“tick” 

button. 

N/A It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

2 Check submit 

status if 

inputting invalid 

email address. 

1. Input 

invalid 

email 

address. 

2. Click 

“tick” 

button. 

a It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

3 Check submit 

status if 

inputting email 

that has not been 

signed up. 

1. Input valid 

email that 

has not 

been 

signed up 

before. 

aa@gmail.com It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 
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2. Click 

“tick” 

button. 

4 Check submit 

status if input 

the correct 

information. 

1. Input valid 

and correct 

email 

address. 

2. Click 

“tick” 

button. 

xinmi503@1utar.my It should 

show 

success 

message at 

the top of 

the input 

field and 

user will 

receive an 

email to rest 

the 

password. 

Pass 

 

 

Figure 6.2.2.1-T3(1):  

Empty Email (Test 

Case 1) 

Figure 6.2.2.1-T3(2):  

Invalid Email (Test 

Case 2) 

Figure 6.2.2.1-T3(3):  

Account Not Exists 

(Test Case 3) 

Figure 6.2.2.1-T3(4):  

Submit Successful 

(Test Case 4) 
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Figure 6.2.2.1-T3(5): Reset Password Email Received (Test Case 4) 

 

 
 

 

  

Figure 6.2.2.1-T3(6):  

Reset Password (Test 

Case 4) 

Figure 6.2.2.1-T3(7):  

Reset Password Successful 

(Test Case 4) 
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Test 4: Update Username 

Requirements for updating username: 

• Input field should not be blank. 

• Username should not be same with the current. 

Table 6.2.2.1-T4: Unit Testing - Update Username 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check required 

field by not 

filling any data. 

1. Do not fill 

in any data 

for the 

input field. 

2. Click the 

“tick” 

button. 

N/A It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

2 Check update 

status if input the 

same username 

to the current. 

1. Input the 

same 

username. 

2. Click 

“tick” 

button. 

Lam It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

3 Check update 

status if input a 

new username. 

1. Input a 

new 

username. 

2. Click 

“tick” 

button. 

Lamm It should 

show 

success 

message at 

the top of 

the input 

fields. 

Pass 
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Test 5: Update Password 

Requirements for updating password: 

• All the input fields should not be blank. 

• The current password must be correct. [current password for this account: UPassThis!88] 

• Both the new password and confirmation password must be matched. 

• Password length must be equal or greater than 8. 

• Password must mix with both characters and digits. 

Table 6.2.2.1-T5: Unit Testing - Update Password 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check required 

field by not 

filling any data. 

1. Do not fill 

in any data 

N/A It should 

show error 

message at 

Pass 

Figure 6.2.2.1-T4(1):  

Empty Username (Test 

Case 1) 

Figure 6.2.2.1-T4(2):  

Same Username (Test 

Case 2) 

Figure 6.2.2.1-T4(3):  

New Username (Test 

Case 3) 
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for the 

input field. 

2. Click the 

“tick” 

button. 

3. Repeat 

steps 

above for 

all the 

other input 

fields. 

the top of 

the input 

fields. 

2 Check update 

status if 

inputting 

different 

password. 

1. Input the 

correct 

current 

password. 

2. Input 

different 

password 

for new 

password 

and verify 

password. 

3. Click 

“tick” 

button. 

Current password: 

UPassThis!88 

Password: 

UPassThis!28 

Verify password: 

testinggg12 

It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

3 Check update 

status if 

inputting invalid 

password. 

1. Input the 

correct 

current 

password. 

2. Input the 

invalid 

password 

Current password: 

UPassThis!88 

Password: 

asdfghjkl 

Verify password: 

asdfghjkl 

It should 

show error 

message at 

the top of 

the input 

fields. 

Pass  
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to make an 

update. 

3. Click 

“tick” 

button. 

4 Check update 

status if 

inputting a valid 

but incorrect 

password. 

1. Input the 

incorrect 

current 

password 

for the 

account. 

2. Input a 

matched 

password 

to make an 

update. 

3. Click the 

“tick” 

button. 

Current password: 

UPassThis!28 

Password: 

changeme123 

Verify password: 

changeme123 

It should 

show error 

message at 

the top of 

the input 

fields. 

Pass  

5 Check update 

status if 

inputting all the 

valid and correct 

information. 

1. Input the 

correct 

current 

password. 

2. Input the 

same 

password 

for the new 

password 

and verify 

password. 

Current password: 

UPassThis!88 

Password: 

UPassThis!28 

Verify password: 

UPassThis!28 

It should 

show a 

success 

message at 

the top of 

input fields. 

Pass  
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3. Click 

“tick” 

button. 

   

 

Figure 6.2.2.1-T5(1):  

Empty All (Test Case 1) 
Figure 6.2.2.1-T5(2):  

Empty Password 

Fields (Test Case 1) 

Figure 6.2.2.1-T5(3):  

Password Mismatch 

(Test Case 2) 
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Test 6: Update Email 

Requirements for updating email: 

• All the input fields should not be blank. 

• Email should be different from the current. [current email: xinmi503@1utar.my] 

• Email must be valid and not registered before. 

Table 6.2.2.1-T6: Unit Testing - Update Email 

Test 

Case 

Description Actions Test Data Expected 

Result 

Status 

1 Check update 

status if 

inputting with 

1. Input an 

invalid 

email 

address. 

Email: aa 

Password: 

UPassThis!28 

It should 

show error 

message at 

the top of 

Pass 

Figure 6.2.2.1-T5(4):  

Invalid Password 

(Test Case 3) 

Figure 6.2.2.1-T5(5):  

Incorrect Current 

Password (Test Case 4) 

Figure 6.2.2.1-T5(6):  

Password Update 

Successful (Test Case 5) 
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an invalid 

email address. 

2. Input the 

correct 

password. 

3. Click 

“tick” 

button. 

the input 

fields. 

2 Check update 

status if 

inputting the 

same email 

address. 

1. Input with 

the same 

email 

address as 

current. 

2. Click 

“tick” 

button. 

xinmi503@1utar.my It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

3 Check update if 

inputting email 

address that has 

been registered 

before. 

1. Input 

email 

address 

that has 

been 

registered 

before. 

2. Input the 

correct 

password. 

3. Click 

“tick” 

button. 

Email: 

xinmi44@gmail.com 

Password: 

UPassThis!28 

It should 

show error 

message at 

the top of 

the input 

fields. 

Pass 

4 Check update 

status if leaving 

blank on the 

password field 

1. Input a 

new email 

without 

registering 

before. 

Email: 

xinmi1986@gmail.com 

Password: 

 

It should 

show error 

message at 

the top of 

Pass 
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2. Click 

“tick” 

button. 

the input 

fields. 

5 Check update 

status if 

inputting with 

all the correct 

and valid 

information. 

1. Input a 

valid 

email that 

has not 

been 

registered 

before. 

2. Input 

correct 

password. 

3. Click 

“tick” 

button. 

Email: 

xinmi1986@gmail.com 

Password: 

UPassThis!28 

It should 

show a 

success 

message at 

the top of 

the input 

fields. 

 

    

Figure 6.2.2.1-T6(1):  

Invalid Email (Test 

Case 1) 

Figure 6.2.2.1-T6(2):  

Same Email (Test 

Case 2) 

Figure 6.2.2.1-T6(3):  

Occupied Email (Test 

Case 3) 
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Figure 6.2.2.1-T6(6): Notification Email Received (Test Case 5) 

 

  

Figure 6.2.2.1-T6(4):  

Empty Password (Test 

Case 4) 

Figure 6.2.2.1-T6(5):  

Email Update Successful 

(Test Case 5) 
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6.2.2.2 Bone Module 

There are different features included in bone module, where it allows users to interact with the 

3D bone models (rotate, scale, touch), add text as notes, read basic information. The parameter 

used for testing this module involves time, which represents the responsiveness of the 

application when user trying to interact with the bone models and retrieve or upload notes data 

from and to the cloud. 

Test 1: Upload Notes to Firebase Cloud 

 
Figure 6.2.2.2-T1(1): Code - Upload Notes to Firebase 

 
Figure 6.2.2.2-T1(2): Results - Uploading Notes to Firebase Cloud 
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Table 6.2.2.2-T1: Time Testing - Notes Uploading to Firebase Cloud 

Test time Start time (in ms) Finish time (in ms) Time taken (in ms) 

1 5681.9 5681.9 0 

2 11695.05 11695.05 0 

3 15006.77 15006.77 0 

4 21270.47 21270.47 0 

5 28285.06 28285.06 0 

6 31529.27 31529.27 0 

7 38297.36 38297.36 0 

8 44778.7 44778.7 0 

9 47696.53 47696.53 0 

10 66070.53 66070.53 0 

Average 0 

There is a total of 10-time tests on this feature. Figure 6.2.2.2-T1(1) indicates the coding for 

uploading notes to firebase cloud. There are 2 lines of codes added to deal with this test, which 

is displaying the system time before and after calling the uploadFirebase() function. As Table 

6.2.2.2-T2 shows, the speed of retrieving data is very fast, and there is no gap between the start 

time and finish time. 
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Test 2: Retrieve Realtime Data from Firebase Cloud 

 
Figure 6.2.2.2-T2(1): Code - Retrieve Realtime Data from Firebase Cloud 

 
Figure 6.2.2.2-T2(2): Results - Retrieving Realtime Data 
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Table 6.2.2.2-T2: Time Testing - Retrieving Realtime Data 

Test time Start time (in ms) Finish time (in ms) Time taken (in ms) 

1 58936.11 58936.11 0 

2 58960.13 58960.13 0 

3 60793.33 60793.33 0 

4 60815.83 60815.83 0 

5 62870.56 62870.56 0 

6 62893.39 62893.39 0 

7 82437.81 82437.81 0 

8 82466.54 82466.54 0 

9 85184.01 85184.01 0 

10 85208.17 85208.17 0 

Average 0 

Figure 6.2.2.2-T2(1) represents the code of retrieving data from firebase cloud in real time. 

There are 2 lines of codes added to identify the actual time taken to retrieve the data. There is 

a total of 10 times of testing has run for this test. As Table 6.2.2.2-T2 shows, the speed of 

retrieving data is very fast, and there is no gap between the start time and finish time. 
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Test 3: Bone Interaction 

Table 6.2.2.2-T3(1): Unit Testing - Bone Interaction 

Test 

Case 

Description Actions Test Data Expected Result Status 

1 Check if the 

labeling is 

functioning 

well. 

1. Disable the 

rotate feature 

if it is 

currently 

active by 

clicking again 

on it. 

2. Touch any part 

of the 3D bone 

model. 

3. Repeat step 1 

to touch other 

part of the 

model. 

Touch input 

with one 

finger or 

mouse click 

and drag 

It should display a 

label along with a 

highlight colour on 

the part of the bone 

if user touches the 

part of the bone 

with labeling. 

Pass 

2 Check if the 

rotation 

feature is 

functioning 

well. 

1. Disable the cut 

feature if it is 

currently 

active by 

clicking again 

on it. 

2. Click on the 

“Rotate” 

button. 

3. Swipe left, 

right, up, and 

down on the 

bone model. 

Touch input 

with one 

finger or 

mouse click 

and drag 

The 3D bone model 

should be able to 

turn around if user 

swiping around the 

screen  

Pass 
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3 Check if the 

cutting feature 

is functioning 

well. 

1. Disable the 

rotate feature 

if it is 

currently 

active by 

clicking again 

on it. 

2. Click on the 

“Knife” 

button. 

3. Swipe around 

the bone 

model. 

Touch input 

with one 

finger or 

mouse click 

and drag 

It should show a 

colouring cut effect 

on the screen, and 

display with an 

inner femur bone 

model along with 

the cutting sound 

effect. 

Pass 

4 Check if the 

scaling feature 

is functioning 

well. 

1. Zoom the 3D 

bone model in 

and out with 2 

fingers. 

Touch input 

with 2 fingers 

The 3D bone model 

should be smaller if 

user try to zoom 

out, and be larger if 

zoom in. 

Pass 

 

• Achivaibility test on bone model rotation 

This test is mainly to test the rotation feature when swiping up, down, left, and right on the 

bone model. There is a total of 10-time tests on the correctness of the bone model rotation 

direction based on the swipe direction. Table 6.2.2.2-T3(2) and Figure 6.2.2.2-T3(1) have 

clearly illustrated the relationship between swipe direction and bone model rotation direction, 

while Table 6.2.2.2-T3(3) represents the results.  

Table 6.2.2.2-T3(2): Relationship between Swipe Direction and Bone Model Rotation Direction 

Swipe Direction Bone Model Rotation Direction 

Up, down Rotate in y-axis 

Left, right Rotate in x-axis 
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Figure 6.2.2.2-T3(1): Relationship between Swipe Direction and Bone Model Rotation Direction 

Table 6.2.2.2-T3(3): Achievability Testing - Bone Rotation  

Test time Status 

1 Success 

2 Success 

3 Success 

4 Success 

5 Success 

6 Success 

7 Success 

8 Success 

9 Success 

10 Success 

 

• Acievability test on bone model cutting 

This test is mainly to test the achievability on cutting the bone model, and its ability to play 

sound effect if user cut the bone successfully. There is a total of 10-time tests for this feature. 
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Figure 6.2.2.2-T3(2): Bone Cutting 

Table 6.2.2.2-T3(4): Achievability Testing - Bone Cutting 

Test time Status 

1 Success 

2 Success 

3 Success 

4 Success 

5 Success 

6 Success 

7 Success 

8 Success 

9 Success 

10 Success 

 

• Achievability Testing on bone model scaling 

This test is to test the feature working properly if repetitively scaling (either zoom in and zoom 

out) the bone model. There is a total of 10-time tests for done for this feature. 
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Table 6.2.2.2-T3(5): Achievability Testing - Bone Scaling 

Test time Status 

1 Success 

2 Success 

3 Success 

4 Success 

5 Success 

6 Success 

7 Success 

8 Success 

9 Success 

10 Success 

 

6.2.2.3 Quiz Module 

Test 1: Overall Quiz Process 

Table 6.2.2.3-T1: Unit Testing - Quiz 

Test 

Case 

Description Actions Test Data Expected Result Status 

1 Check if quiz 

questions are 

able to display 

properly and 

allow user to 

select the 

answer. 

1. Click “Start” 

button. 

2. Check all the 

answers. 

3. Uncheck all 

the answers. 

N/A The UI should 

perform perfectly. 

Pass 
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2 Check whether 

the explanation 

displayed if 

users choose 

the wrong 

answer. 

1. Select a wrong 

answer for any 

question. 

2. Click 

“Submit” 

button. 

The wrong 

answer 

It should display an 

explanation to user. 

Pass 

3 Check if the 

resolution 

screen display 

after user 

answer on each 

question. 

1. Choose any of 

the answers. 

2. Click 

“Submit” 

button. 

3. Click “Next” 

button. (if 

wrong answer 

chosen) 

Any of the 

answers 

It should display a 

resolution screen to 

user along with the 

status of 

correctness as well 

as the current score. 

Pass 

3 Check if the 

question is 

changed 

properly. 

1. Choose any of 

the answers. 

2. Click 

“Submit” 

button. 

3. Click “Next” 

button. (if 

wrong answer 

is chosen) 

Any of the 

answers 

It should display 

another question to 

user after the 

resolution screen 

unless there are no 

other questions. 

Pass 

4 Check the 

changes in 

scores.  

1. Choose any of 

the answers. 

2. Click 

“Submit” 

button. 

Any of the 

answers 

The score at the top 

left corner is 

updated 

accordingly, as 

well as the current 

score in the 

temporarily 

resolution screen. 

Pass 
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5 Check if the 

final result 

screen is 

displayed 

properly. 

1. Choose any of 

the answers. 

2. Click 

“Submit” and 

“Next” button 

if wrong 

answer 

chosen. 

3. Repeat steps 1 

and 2 until 

there are no 

other 

questions. 

Any of the 

answers 

The final result 

screen id displayed 

properly along with 

the final score and 

history highest 

score. (If current 

score is the highest 

score, it should 

show a “new” word 

in front of the 

highest score) 

Pass 

 

Test 2: Score Retrieved from Firebase Cloud to Display Leaderboard 

 
Figure 6.2.2.3-T2(1): Code - Retrieve Score and Display Leaderboard from Firebase Cloud 
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Figure 6.2.2.3-T2(2): Results - Retrieving Score and Displaying Leaderboard 

Table 6.2.2.3-T2: Time Testing - Retrieving Score and Displaying Leaderboard 

Test time Start time (in ms) Finish time (in ms) Time taken (in ms) 

1 2399.334 2399.334 0 

2 8782.11 8782.11 0 

3 10377.44 10377.44 0 

4 11657.29 11657.29 0 

5 12900.5 12900.5 0 

6 14268.97 14268.97 0 

7 15744.2 15744.2 0 

8 17237.41 17237.41 0 

9 18654.84 18654.84 0 
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10 21082.36 21082.36 0 

Average 0 

 

6.2.2.4 Learning Module 

Test 1: Video Playing 

There are 2 types of tests included in this module, which are unit testing and Achievability 

Testinging. The intention of using unit testing in this module is to test the video playing ability, 

while the Achievability Testing is to test if the video would continue playing if clicking on the 

“fullscreen” and “minscreen” buttons repeatedly, as well as for the “start” and “pause” button. 

• Unit Testing 

Table 6.2.2.4-T1(1): Unit Testing – Video Playing 

Test 

Case 

Description Actions Test Data Expected Result Status 

1 Check if video 

can be played 

with sound. 

1. Click “Play” 

button. 

N/A The video should 

be able to play with 

sound. 

Pass 

2 Check if video 

can be play in 

fullscreen 

mode. 

1. Click “Play” 

button. 

2. Click 

“fullscreen” 

button. 

Note: Step 1 and 2 

can be done 

interchangeably. 

N/A The video should 

be able to play in 

fullscreen mode. 

Pass 

3 Check if video 

can be continue 

playing after 

pausing. 

1. Click “Play” 

button. 

2. Click “Pause” 

button. 

N/A The video should 

be able to continue 

playing after 

pausing. 

Pass 
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3. Repeat step 1 

and 2. 

4 Check if video 

can be continue 

playing on 

previous state 

after clicking 

to another tab. 

1. Click “Play” 

button. 

2. Click another 

tab of video 

list. 

3. Click back to 

previous tab of 

video list. 

N/A The video should 

be able to continue 

playing from 

previous state. 

Fail 

• Achievability Testing 

Table 6.2.2.4-T1(2): Achievability Testing - Video Playing (Fullscreen & Minscreen) 

Test time Status 

1 Success 

2 Success 

3 Success 

4 Success 

5 Success 

6 Success 

7 Success 

8 Success 

9 Success 

10 Success 

 

Table 6.2.2.4-T1(3): Achievability Testing - Video Playing (Start & Pause) 

Test time Status 

1 Success 

2 Success 

3 Success 

4 Success 
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5 Success 

6 Success 

7 Success 

8 Success 

9 Success 

10 Success 

 

Test 2: General Information 

There is only text and images to be displayed in this module, hence the test cases for this 

module are only to ensure the information can be displayed perfectly in both the portrait and 

landscape mode. 

Table 6.2.2.4-T2: Unit Testing – General Information 

Test 

Case 

Description Actions Test Data Expected Result Status 

1 Check if the 

information 

can be display 

perfectly in 

portrait mode. 

1. Remain 

portrait mode 

of the mobile 

device or 

simulator. 

N/A The information of 

text and images 

should be displayed 

perfectly and no 

overlapping. 

Pass 

2 Check if the 

information 

can be 

displayed 

perfectly in 

landscape 

mode. 

1. Rotate the 

mobile device 

or simulator to 

landscape 

mode. 

N/A The information of 

text and images 

should be displayed 

perfectly and no 

overlapping. 

Pass 
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6.2.2.5 Offline Testing 

Since this system is developed for both online and offline usage, this testing is inevitable and 

is essential to ensure the data is consistent and minimise the risk of encountering the issue of 

data loss. There are few steps taken to conduct this test: 

1. Log in to the Firebase Cloud and get the current data. 

2. Disconnect the internet. 

3. Modify and save data in the simulator. 

4. Connect back to the internet. 

5. Observe the change in Firebase Cloud. 

Figure 6.2.2.5-1 shows the data that have stored in Firebase Cloud, Figure 6.2.2.5-2 shows the 

data have been modified without the internet, Figure 6.2.2.5-3 shows the changes in Firebase 

Cloud after re-connect back to the internet. 

To achieve this, it is actually through comparing the timestamps.  

In conclusion, this offline testing has passed. 

 

Figure 6.2.2.5-1: Offline Test - Data Saved Previously in the Cloud 
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Figure 6.2.2.5-2: Offline Test - Data Modified without the Internet 

 

Figure 6.2.2.5-3: Offline Test – Data Updated with the Internet 
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6.2.2.6 Background Music  

Table 6.2.2.6-T1: Unit Testing – Background Music 

Test 

Case 

Description Actions Test Data Expected Result Status 

1 Check if the 

background 

music is played 

normally when 

first start the 

app. 

1. Run the app. N/A The background 

music should be 

able to play. 

Pass 

2 Check if the 

background 

music status if 

playing video. 

1. Play a video. N/A The background 

music should be 

muted 

automatically. 

Pass 

3 Check if the 

background 

music status if 

click on the 

“Mute” button. 

1. Click “Main 

Menu” button. 

2. Click “Mute” 

button. 

N/A The background 

music should be 

muted. 

Pass 

4 Check if the 

background 

music status if 

click on the 

“Sound” 

button. 

1. Click “Main 

Menu” button. 

2. Click “Sound” 

button. 

N/A The background 

music should be 

able to play 

normally again. 

Pass 

5 Check if 

background 

music status on 

restarting the 

app after 

1. Click “Mute” 

button. 

2. Close the app. 

3. Run the app 

again. 

N/A The background 

music should be 

muted by default. 

Pass 
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clicking 

“Mute” button. 

 

6.2.2.7 Survey Testing Result 

There are a total of 9 questions designed for this testing, and there are 15 individuals 

participating in it. Since the target users of this project are not medical professionals, none of 

the respondents had a medical background.  

 

Figure 6.2.2.7-1: Survey Testing - Q1 

As in Figure 6.2.2.7-1, all the respondents agree that the application is easy to use, which can 

be attributed to the navigational design of the application, which makes it possible for users to 

use the feature quickly at a glance. This is the most basic but extremely important for 

developing a mobile application as it will directly affect the user experience if the design of 

navigation is difficult to understand.  
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Figure 6.2.2.7-2: Survey Testing – Q2 

Aligning with the project title, there is a question about the ease of learning on human femur 

and its potential shaft fractures. This is considered an important concern as people are always 

trying to look for the easiest and fastest way to acquire new knowledge. As shown in Figure 

6.2.2.7-2, all the respondents agree that this mobile application makes it easy to learn about the 

human femur and its potential shaft fracture. 

 

Figure 6.2.2.7-3: Survey Testing – Q3 

It is important that the information is adequate for an educational mobile application, hence 

this question is designed. As Figure 6.2.2.7-3 illustrated, from the small group of respondents 
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who were without the medical background, they found that the information is adequate for 

them to learn about the human femur and its potential shaft fracture. 

 

Figure 6.2.2.7-4: Survey Testing – Q4 

Since this application is designed to allow users to use it across different devices, storing data 

in the cloud is needed, and therefore, this question is designed. Figure 6.2.2.7-4 shows that all 

the respondents feel that this application allows them to retrieve and backup data in an easy 

way. 

 

Figure 6.2.2.7-5: Survey Testing – Q5 

Figure 6.2.2.7-5 indicates that all the respondents are interested in using the application to learn 

human femur and its potential shaft fractures. 
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Figure 6.2.2.7-6: Survey Testing – Q6 

As the pie chart in Figure 6.2.2.7-6 shown, 73.3% of respondents like the feature of interacting 

with the bone models, 13.3% of the respondents like the quiz game, and others (13.4%) like 

the feature of notes and video lists. This can be concluded that most of the respondents prefer 

the interaction with the bone models, maybe because 3D models can provide an immersive 

visualisation and bring new experience for them to learn about the human femur. 

 

Figure 6.2.2.7-7: Survey Testing – Q7 

As in Figure 6.2.2.7-7, almost all the respondents are satisfied on the user interface of this 

application.  



Bachelor of Information Systems (Honours) Information Systems Engineering  
Faculty of Information and Communication Technology (Kampar Campus), UTAR 
                                                         

130 
 

 

Figure 6.2.2.7-8: Survey Testing – Q8 

The overall performance is also satisfied by most of the respondents. Hence, this is considered 

a good start for the development of this application. 
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Figure 6.2.2.7-9: Survey Testing – Q9 

There are some invaluable feedbacks got from respondents throughout the entire survey. Some 

of them have provided useful insight into prospective directions to elevate the application to a 

greater height. For instance, suggestions on adding more bone and more interaction options to 

the bone, which can lead to a better experience for users to learn human femur. Besides, adding 

additional resources to supplement the 3D visualisation by including more reference materials 

or some real cases can raise interest of users to explore more on the human femur. There are 

also some respondents request to enhance the video list and notes features.  
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6.3 Objectives Evaluation 

Objective 1: To develop an informative educational mobile application for users to gain 

knowledge of the human femur in detail so that they can master the anatomy of the 

human femur easily. (Achieved, but some features may not efficient enough) 

Aligned with the project title, the mobile application has been created solely based on the 

human femur, and mainly focuses on human femoral shaft fractures. There is labelling designed 

for different structures of the 3D human femur bone model along with highlight colour. Not 

only the outer part but also the inner part of the bone model has been created and imported to 

the mobile application. Besides, there is additional information, such as some facts, risk factors, 

general approximate healing time, possible treatments, complications, and different 

classifications for human femoral shaft fractures where users can always check on that. While 

putting focus back to the femoral shaft fractures, there are 4 most common types of femoral 

shaft fractures have also been created and imported into this mobile application, which 

allowing users to have a better sight on the different types of fractures. Furthermore, there are 

3 categories of video lists included in this mobile application, which assist users to have a more 

understanding of human femur and its potential shaft fractures. However, the feature of video 

lists developed is inadequate because there is no scrub control and is not able to continue 

playing from the previous state after clicking to another tab of video lists. Video lists with scrub 

control can be a complex task as it not only requires knowledge of mobile app development 

but also the knowledge of video codec. To sum up, this objective is considered achieved, but 

not efficient. 

Objective 2: To develop a better learning experience for users to learn the anatomy of the 

human femur and its potential shaft fractures. (Achieved, but some features may not 

efficient enough) 

A mobile application is able to enhance the overall learning experience thanks to its easy 

portability, which allows users to continue their learning anywhere and anytime. Besides, as 

stated in the previous objective, there are different 3D bone models that have been included in 

this mobile application which can provide a way to visualise and interact with those complex 

anatomical structures in a more intuitive and immersive way. The interaction features 

developed in this mobile application involve rotation, scaling, and cutting. Moreover, this 
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mobile application is developed along with a note feature, which allows users to save their 

notes for further revision. Even if the notes feature is inadequate, as it only supports saving text 

as notes, it can still serve as a short note for users to record their brief notes while learning 

without using paper or books. The reason that the notes feature is not able to achieve in a more 

efficient way is that it is a complex task, and also require a deep understanding of the 

“TextMeshPro” component, maybe also along with some plug-in from Unity that I am 

currently consisting of not enough time to deal with it. Furthermore, as previously stated, this 

mobile application is developed to support both online and offline. Again, it benefits users to 

learn without the internet, which supports the statement that users can continue learning at any 

time. Also, users can no longer worry about data loss due to network issues, an example is the 

notes being saved abnormally. The offline testing part also proves that, upon reconnecting to 

the internet, all locally saved data would be instantly updated in the cloud. Lastly, there is a 

simple quiz game developed along with a leaderboard to increase the interest of users in 

continuing to use this mobile application. Other than testing users’ current knowledge levels, 

the leaderboard, which also acts as a ranking, might motivate users to continue their study so 

they can achieve a better score for the quiz at the next attempt. This ultimately creates a better 

learning experience and improves the interest of users in using this mobile application, and the 

objective is also considered achieved. 

Objective 3: To develop a completely free educational mobile application devoid of any 

advertisements so that lessen user strain from having to purchase pricey software or real 

bone which might be hard to come by. (Achieved) 

Based on previous research and reviews, most of the applications are costly to use, which 

results in a burden on users who really need the application for learning purposes. Besides, 

some of them consist of advertisements while using them, which can directly affect the user 

experience. Hence, this application is ultimately developed, requires zero cost to use and 

devoid of any advertisements.  
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6.4 Concluding Remark 

This chapter is mainly focused on the testing and evaluation of the entire developed system. 

By observing the results and objectives evaluation, this project has passed most of the tests and 

achieved all the objectives. 
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Chapter 7 

Conclusion and Recommendation 
 

7.1 Conclusion 

Throughout the entire development process, there are a lot of issues and challenges that have 

been encountered, such as extra time needed to learn the new tools that are required to develop 

this project. The tools include Unity, Blender, and Firebase realtime database. For instance, to 

deal with the data synchronisation feature in this project, it is necessary to have a prior 

understanding of the framework of the Firebase realtime database.  Besides, 3D is another new 

learning area that I have not explored previously. It is a complex topic to learn within a short 

period because it requires numerous technical skills and software knowledge in order to 

produce a high-quality 3D model, and it covers a lot of topics too, such as geometry, lighting, 

texturing, and rendering.  

Additionally, when trying to create a mobile application using Unity, there are a lot of issues 

that I have encountered, the most common issue is regarding the user interface. It is sometimes 

difficult and trouble to deal with due to a lack of understanding of the component structure and 

its order. Moreover, since Unity is a powerful and feature-rich game engine, which also means 

that it has a steep learning curve, and sometimes the features can be difficult to learn and 

master. For instance, the “TextMeshPro” component is not simply for displaying text, but it 

also consists of several features, such as rich-text, dynamic text sizing, text styling, and others. 

It also has the ability to create high-quality and stylish text by applying textures. Because there 

is so much to learn from just one component, it is understandable that mastering Unity to create 

a solid mobile application can be challenging. 

Other than the tools, human femur is another new topic that I should learn while developing 

this project. This is because I am not a biology student and have not even taken biology subjects 

previously. The femur is a complex bone, and understanding its anatomy and structure requires 

knowledge of medical terminology and concepts that may be unfamiliar. It can also be difficult 

for me to learn about potential shaft fractures because it requires an understanding of the forces 

that can cause the fracture, such as traumatic injuries or underlying medical conditions. 
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Additionally, the treatment and management of femur fractures may require knowledge of 

surgical procedures, medical devices, and rehabilitation techniques that are outside my 

expertise. Hence, learning about the human femur and its potential shaft fracture requires a 

strong foundation in anatomy, physiology, and medical terminology, which can be challenging 

for me as a non-biology student. 

In conclusion, this project has ultimately come up with a mobile application for users to learn 

about the human femur and its potential shaft fractures. The application offers interactive and 

immersive visualisations of the femur bone, common types of fractures, and their 

corresponding treatment options. Besides, the application is designed to be user-friendly and 

accessible to everyone, providing a comprehensive and engaging educational resource. The 

main modules involved in this application include bone module, quiz module, profile module, 

and learning module. It was tested and evaluated by a group of users without a medical 

background, who provided valuable feedback to enhance the user experience. Overall, this 

project provides a novel approach to the educational field and has the potential to increase the 

awareness of femoral shaft fractures among non-medical professionals, promoting a better 

understanding of human anatomy and injuries.  

 

7.2 Recommendation 

Nothing is perfect, everything still can be improved, and there is no exception for this project.  

There is still a lot of space for this project to improve. According to the feedback from the 

survey, there are some valuable suggestions that have been mentioned. All the suggestions will 

be taken into consideration in order to enhance the overall quality of the system. For instance, 

including more bone and interaction options for the bones allow making it a more interesting 

way for users to learn about the human femur, and including more reference materials or some 

real cases could make the application a more comprehensive learning tool. Then, making the 

video to be controllable is always an ideal way because it makes it easy for users to watch the 

video. The notes feature can also be enhanced to allow users to design their special notes for 

easy revision, such as allowing highlighting and bold text, maybe allowing them to add images 

and drawing also if possible. Besides, there is one of the features that mentioned in previous 

chapter has not been done, which is allow highlighting any part of the bone structure. This can 
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also be the future work of this project. Lastly, including a different set of quiz questions is also 

essential to test the users’ knowledge thoroughly. I believe this can improve the overall user 

experience if all the mentioned recommendations have been done and achieved.  
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(Project II) 

 
Trimester, Year: T3Y3 Study week no.: 2 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Modify the overall UI and some of the structure of Unity project. 
- Complete user login and register module. 
- Complete notes module. 
- Review technologies might be involved in this project (report chapter 2) and add 

additional information to background (report chapter 1). 
 

2. WORK TO BE DONE 
 
- Learn modeling skills on breaking the bone. 
- Labeling the bone structure. 
- Look for more information about bone fractures. 
 
3. PROBLEMS ENCOUNTERED 
 
- The size of notes and information panel remains immutable, maybe there is an issue 

on the code that has not been figured out. 
- 3D models can only rotate from the middle, because of using the cube collision and 

tag. 
- Video unable to play on full screen. 
 
4. SELF EVALUATION OF THE PROGRESS 
 
To prevent the FYP progress fall behind schedule at the beginning of the new trimester 
start (because of being busy seeking internship companies, interviews, catch up on the 
progress in the class of another subject), I try to do more during my semester break. The 
overall progress is considered smooth, and I have completed the login and register 
module, as well as the note backup module.  
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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Trimester, Year: T3Y3 Study week no.: 4 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Complete chapter 3 of the report and modify chapter 4 (add activity diagrams for 

login and register module, as well as note backup module). 
- Start learning some modeling skills through YouTube. 
- Reorganize and plan tasks of the project according to priority. 
 
2. WORK TO BE DONE 
 
- Cut intact bone into different parts/structure for later labeling. 
- Solve notes and information panel resize issue. 
- Solve video unable to play in full screen issue. 
- Design the label for showing information or name of the particular bone part. 
 
 
3. PROBLEMS ENCOUNTERED 
 
- No critical issue found. 
 
 
 
4. SELF EVALUATION OF THE PROGRESS 
 
Even if busy completing assignment and preparing documents for applying internship 
job, I still try my best to work on some part of the report and learn some modeling skills. 
Besides, to ensure myself is always clear on what to do for the project, I made a plan, list 
down all the current FYP small tasks, and reorganize them for easy referring and working 
on it. 
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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Trimester, Year: T3Y3 Study week no.: 6 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Complete chapter 2 of the report. 
- Cut the intact femur bone model into different parts. 
- Add tag to each of the parts and apply colour on clicked part of a particular bone 

structure. 
 
2. WORK TO BE DONE 
 
- Design the label for showing information or name of the particular bone part. 
- Solve notes and information panel resize issue. 
- Solve video unable to play in full screen issue. 
- Cut and model for the inner part of femur bone. 
 
 
3. PROBLEMS ENCOUNTERED 
 
- No critical issues found. 
 
 
 
 
4. SELF EVALUATION OF THE PROGRESS 
 
Although there are a lot of job interview sessions ongoing, I try to deal with a little of the 
report and cutting the intact bone model into different parts for labeling. The progress 
maybe slow since week 4, but overall progress in considered on the track. 
 
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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Trimester, Year: T3Y3 Study week no.: 8 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Complete modeling inner part of the femur bone. imported into Unity and added tag 

for each of the parts. 
- Draft designing the labeling for showing the bone structure naming. 
- Fix model rotation issue by only activating rotation feature after clicking on a button. 
- Rearrange part of the report. 
- Fix slider menu bug by adding additional vertical layout group. 
- Fix information content resize. 
 
2. WORK TO BE DONE 
 
- Solve video unable to play in full screen issue. 
- Add feature on allowing user to cut the bone. 
- Add more information regarding the bone fractures. 
- Add more quiz questions. 
 
3. PROBLEMS ENCOUNTERED 
 
- Output of inner bone texture exported anomaly, result show different in Blender and 

Unity. 
 
4. SELF EVALUATION OF THE PROGRESS 
 
Everything was considered to progress smoothly. Time allocated effectively to complete 
desired tasks within 2 weeks. However, still have to work harder to get all tasks 
completed with the least bugs. 
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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Trimester, Year: T3Y3 Study week no.: 10 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Done adding cut feature. 
- Modify the button by only allowing user to click on either rotate or cut button at once 

but not both. 
 

 
2. WORK TO BE DONE 
 
- Solve video unable to play in full screen issue. 
- Add more information regarding the bone fractures. 
- Add more quiz questions. 
- Complete full report with poster. 
 
3. PROBLEMS ENCOUNTERED 
 
- No critical issue found. 
 
 
 
4. SELF EVALUATION OF THE PROGRESS 
 
 
 
 
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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Trimester, Year: T3Y3 Study week no.: 12 
Student Name & ID: Lam Xin Mi (19ACB02794) 
Supervisor: Ts Saw Seow Hui 
Project Title: A 3D Educational Mobile Application for Femoral Shaft Fractures 

 
 
1. WORK DONE 
[Please write the details of the work done in the last fortnight.] 
 
- Complete the feature for enabling fullscreen video playing. 
- Complete overall system functions. 
- Repeat testing and fixing bugs. 
- Complete report with poster. 
 
 
2. WORK TO BE DONE 
 
 
 
 
3. PROBLEMS ENCOUNTERED 
 
- No critical issue found. 
 
 
 
 
4. SELF EVALUATION OF THE PROGRESS 
 
 
 
 
 

 
 
 
 
 
_________________________      _________________________ 
  Supervisor’s signature            Student’s signature 
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